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Symbols and definitions
 

Documentation symbols
For information on the origin of these symbols, see the Welch Allyn symbols glossary: https://
www.hillrom.com/content/dam/hillrom-aem/us/en/sap-documents/LIT/80022/
80022945LITPDF.pdf.

WARNING The warning statements in this manual identify conditions or practices
that could lead to illness, injury, or death. Warning statements appear with a grey
background in a black and white document.

CAUTION The caution statements in this manual identify conditions or practices
that could result in damage to the equipment or other property, or loss of data.

Follow instructions/directions for use (IFU) -- mandatory action.

A copy of the IFU is available on this website.

A printed copy of the IFU can be ordered from Welch Allyn for delivery within 7
calendar days.

Power symbols
Stand-By Direct current (DC)

Power plug Battery absent or faulty

Alternating Current power
present, battery fully charged

Battery charge level

Alternating Current power
present, battery is charging

Battery
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Alternating current (AC) Rechargeable battery

Rated power input, DC Rated power input, AC

Lithium-ion battery Protective Earth (PE)

Connectivity symbols
USB

Miscellaneous symbols
Manufacturer Defibrillation-proof Type BF

applied parts

Reorder Number Serial Number

Product Identifier Recyclable

Do not reuse, Single use
device Separate collection of

Electrical and Electronic
Equipment. Do not dispose as
unsorted municipal waste.

IPX2 IP = International Protection
Marking

X = No object ingress rating

2 = Protected against
vertically falling water drops
when enclosure tilted up to
15°

Call for maintenance

This way up Fragile
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Authorized Representative in
the European Community

This device has no alarms.

Temperature limit Global Trade Item Number

Stacking limit by number Keep dry

Humidity limitation Atmospheric pressure
limitation

Medical Device Prescription only or "For Use
by or on the order of a
licensed medical professional"

Non-ionizing electromagnetic
radiation

Mobile stand symbols
Maximum safe working load
limits

Mass in kilograms (kg)

CAUTION The caution statements in this manual identify conditions or practices that
could result in damage to the equipment or other property, or loss of data.

Screen symbol

Process indicator for activities like acquiring measurements
and connecting to a laptop
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About warnings and cautions
 

Warning and caution statements can appear on the device, on the packaging, on the shipping
container, or in this document.

The device is safe for patients and clinicians when used in accordance with the instructions and the
warning and caution statements presented in this manual.

Before using the device, familiarize yourself with the sections of this manual that pertain to your use
of the device.

WARNING The warning statements in this manual identify conditions or practices
that could lead to illness, injury, or death.

CAUTION The caution statements in this manual identify conditions or practices
that could result in damage to the equipment or other property, or loss of patient
data.

General warnings and cautions
WARNING Patient injury risk. Many environmental variables, including patient
physiology and clinical application, can affect the accuracy and performance of the
device. Therefore, you must verify all vital signs information, especially NIBP and
SpO2, before treating the patient. If there is any question about the accuracy of a
measurement, verify the measurement using another clinically accepted method.

WARNING Personal injury risk. The power cord plug is the disconnect device used
to isolate this equipment from supply mains. Position the equipment so that it is
not difficult to reach or disconnect the plug.

WARNING Patient injury risk. Damaged cords, cables, and accessories can affect
patient and operator safety. Never lift the device by the power supply cord or
patient connections. Routinely inspect the AC power cord, blood pressure cuff,
SpO2 cable, and other accessories for strain relief wear, fraying, or other damage.
Replace as necessary.

WARNING Patient injury risk. During defibrillation, keep discharge paddles away
from device sensors and other conductive parts in contact with the patient.

WARNING Patient injury risk. Any external compression of the blood pressure
hose or cuff or kinked tubing may cause patient injury, system errors, or inaccurate
measurements.
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WARNING Patient injury risk. Wash hands to reduce the risk of cross-
contamination and nosocomial infection.

WARNING Patient injury risk. Do not place the device in any position that might
cause it to fall on the patient.

WARNING Patient injury risk. Do not place the cuff on the arm on the same side
of a mastectomy or lymph node clearance. If necessary, use the femoral artery in
the thigh to take a measurement.

WARNING Patient injury risk. Inaccurate measurement risk. Do not place the cuff
where it can disturb proper circulation. Do not place the cuff on any area where
circulation is compromised or on any extremity used for intravenous infusions. Do
not place the cuff on any limb where intravascular access or therapy, or an arterio-
vascular (A-V) shunt is present. Observe the limb concerned to ensure that
operation of the device does not result in prolonged impairment of circulation.

WARNING Patient injury risk. Inaccurate measurement risk. Do not use an SpO2
finger clip sensor and a blood pressure cuff simultaneously on the same limb.
Doing so may cause a temporary loss of pulsatile flow, resulting in either no
reading or an inaccurate SpO2 or pulse rate until the flow returns.

WARNING Do not apply cuff to areas on patient where skin is delicate or
damaged, as this can cause further injury. Check cuff site frequently for irritation.

WARNING Equipment failure and patient injury risk. Do not cover the air intake or
exhaust vents on the rear and base of the device. Covering these vents could
cause overheating of the device.

WARNING This equipment is not suitable for use in the presence of electro-
surgery.

WARNING For operator and patient safety, peripheral equipment and accessories
that can come in direct patient contact must comply with all applicable safety,
EMC, and regulatory requirements.

WARNING Equipment damage and personal injury risk. When transporting the
device on a mobile stand, properly secure all patient cables and cords to keep
them clear of the wheels and to minimize trip hazards.

WARNING Equipment damage and personal injury risk. No modifications to the
device are allowed by anyone other than a qualified Welch Allyn service
representative. Modification of the device could be hazardous to patients and
personnel.

WARNING Electric shock hazard. This equipment must only be connected to a
supply mains with protective earth.

WARNING Electric shock hazard. All signal input and output (I/O) connectors are
intended for connection of only devices complying with IEC 60601-1, or other IEC
standards (for example, IEC 60950), as applicable to the device. Connecting
additional devices to the device may increase chassis or patient leakage currents.
Measure the leakage currents to confirm that no electric shock hazard exists.

WARNING Explosion or contamination hazard. Improper disposal of batteries may
create an explosion or contamination hazard. Never dispose of batteries in refuse
containers. Always recycle batteries according to local regulations.
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WARNING Inaccurate measurement risk. The device is not intended for use
during patient transport outside of the medical facility. Do not use the device to
take measurements on any patient in transit.

WARNING Inaccurate measurement risk. Do not connect more than one patient
to a device.

WARNING Inaccurate measurement risk. Dust and particle ingress can affect the
accuracy of blood pressure measurements. Use the device in clean environments
to ensure measurement accuracy. If you notice dust or lint build-up on the
device's vent openings, have the device inspected and cleaned by a qualified
service technician.

WARNING Inaccurate measurement risk. Do not expose to temperatures higher
than 122º F (50º C).

WARNING Inaccurate measurement risk. Do not use the device on patients who
are on heart-lung machines.

WARNING Inaccurate measurement risk. Do not use the device on patients who
are experiencing convulsions or tremors.

WARNING Liquids can damage electronics inside the device. Prevent liquids from
spilling on the device.

If liquids are spilled on the device:

1. Power down the device.
2. Disconnect the power plug.
3. Remove battery pack from the device.
4. Dry off excess liquid from the device.

NOTE If liquids possibly entered the device, remove the device from use
until it has been properly dried, inspected, and tested by qualified service
personnel.

5. Reinstall battery pack.
6. Reconnect the power plug.
7. Power on the device and verify that the device functions normally before using it.

WARNING The device may not function properly if dropped or damaged. Protect
it from severe impact and shock. Do not use the device if you notice any signs of
damage. Qualified service personnel must check any device that is dropped or
damaged for proper operation before putting the device back into use.

WARNING Defective batteries can damage the device. If the battery shows any
signs of damage or cracking, it must be replaced immediately and only with a
battery approved by Welch Allyn.

WARNING Personal injury risk. Improper handling of the battery can lead to heat
generation, smoke, explosion or fire. Do not short-circuit, crush, incinerate, or
disassemble the battery. Never dispose of batteries in refuse containers. Always
recycle batteries according to national or local regulations.

WARNING Use only Welch Allyn approved accessories, and use them according
to the manufacturer’s directions for use. Using unapproved accessories with the
device can affect patient and operator safety and can compromise product
performance and accuracy, and void the product warranty.
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WARNING Welch Allyn is not responsible for the integrity of a facility's power. If
the integrity of a facility's power or protective earth conductor is in doubt, always
operate the device on battery power alone when it is attached to a patient.

WARNING The use of the Spot Vital Signs 4400 device adjacent to or stacked with
other equipment or medical electrical systems should be avoided because it could
result in improper operation. If such use is necessary, the Spot Vital Signs 4400 and
other equipment should be observed to verify that they are operating normally.

WARNING Use only accessories and cables Welch Allyn recommends for use with
the Spot Vital Signs 4400 device. Accessories and cables not recommended by
Welch Allyn may affect the EMC emissions or immunity.

WARNING Maintain minimum separation distance of 12 inches (30 cm) between
any part of the Spot Vital Signs 4400 device and portable RF communication
equipment (including peripherals such as antenna cables and external antennas).
Performance of the Spot Vital Signs 4400 device might degrade if proper distance
is not maintained.

WARNING Use of accessories, transducers, and cables other than those specified
may result in degraded electromagnetic compatibility performance of this device.

WARNING Use of accessories, transducers, and cables other than those specified
may result in increased emissions or decreased immunity of the device.

WARNING Patient harm and equipment damage risk. Carefully route patient
cords and cables to reduce the possibility of patient entanglement. When
transporting the Spot Vital Signs device on a mobile stand, properly secure all
patient cords and cables to keep them clear of the wheels and to minimize trip
hazards.

WARNING Strangulation risk. The cords and cables can wrap around the patient’s
neck. When used on children or vulnerable patient populations, the Spot Vital
Signs 4400 device accessories must only be applied with special care and under
permanent supervision. When used on adults, caution should be taken.

WARNING Choking risk. An oral probe cover enters the patient’s mouth when
taking oral temperatures. When inserting the probe tip inside the mouth of a
patient, ensure that the probe cover remains on the probe tip to avoid the risk of
the patient choking on the probe cover. When using on children or vulnerable
patient populations, the Spot Vital Signs 4400 device must only be used with
special care and under permanent supervision. When used on adults, caution
should be taken.

WARNING Verify the patient vitals data for each entry on the Spot Vital Signs 4400
device before transferring patient records.

CAUTION This device is not intended for use in the home healthcare
environment.

CAUTION Do not operate the device in the presence of magnetic resonance
imaging (MRI) or hyperbaric chambers.

CAUTION Electric shock hazard. Do not sterilize the device. Sterilizing the device
could damage the device.

CAUTION United States Federal law restricts this device to sale, distribution, or
use by or on the order of a physician or licensed healthcare professional.
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CAUTION Electromagnetic interference risk. The device complies with applicable
domestic and international standards for electromagnetic interference. These
standards are intended to minimize medical equipment electromagnetic
interference. Although this device is not expected to present problems to other
compliant equipment or be affected by other compliant devices, interference
issues still may occur. As a precaution, avoid using the device in close proximity to
other equipment. In the event that equipment interference is observed, relocate
the equipment as necessary or consult manufacturer's directions for use.

CAUTION Do not move the stand while the power source is plugged into the
mains outlet.

CAUTION Do not sterilize the device. Sterilizing the device could harm the device.

CAUTION Use only a Class I (grounded) AC power cord to charge the power
source for the device.

CAUTION Never move the device or mobile stand by pulling on any of the cords.
This may cause the device to tip over or damage the cord. Never pull on the
power cord when disconnecting the cord from the mains outlet. When
disconnecting the power cord, always grasp the attachment plug. Keep the cord
away from liquids, heat, and sharp edges. Replace the power cord if the strain
relief, cord insulation, or metal prongs are damaged or begin to separate from the
attachment plug.

CAUTION Do not exceed the maximum weight limits for your mobile stand with
basket or bins. See the "Specifications" section of the device’s Instructions for use for
the basket/bin and mobile stand maximum weight limits.

CAUTION Use only the Welch Allyn USB client cable to connect a laptop
computer to the USB client port. Any laptop connected to the device must be
running on a battery, a 60601-1 compliant power supply, or a 60601-1 compliant
isolation transformer.

CAUTION If the touchscreen is not responding properly, refer to the
troubleshooting section. If the problem cannot be resolved, discontinue use of the
device and contact an authorized Welch Allyn service center or qualified service
personnel.

CAUTION If the device stops operating within its design specifications, remove it
from service and have it inspected by a qualified service person.

Residual risk information
This product complies with relevant electro-magnetic interference, mechanical safety,
performance, and biocompatibility standards. However, the product cannot completely eliminate
potential patient or user harm from the following:

• Harm or device damage associated with electro-magnetic interference,

• Harm from mechanical hazards,

• Harm from device, function, or parameter unavailability,

• Harm from misuse error, such as inadequate cleaning, and/or

• Harm from device exposure to biological triggers that may result in a severe systemic allergic
reaction.
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Adverse event reporting statement (notice to users and/or patients)
Notice to Users and/or Patients in EU: Any serious incident that has occurred in relation to the
device, should be reported to the manufacturer and the competent authority of the Member State
in which the user and/or patient is established.
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Safety
 

All users of the device must read and understand all safety information presented in this manual
before using or repairing the device.

United States federal law restricts this device to sale, distribution, or use by or on the order of a
licensed medical practitioner.

General safety considerations

• If the device detects an unrecoverable problem, it displays an error message. For more
information, see “Troubleshooting.”

• To ensure patient safety, use only accessories recommended or supplied by Welch Allyn. (See
the accessories list in the Appendix of the Instructions for use.) Always use accessories
according to your facility’s standards and according to the manufacturer’s recommendations
and instructions. Always follow the manufacturer’s directions for use.

• Welch Allyn recommends that only Welch Allyn service personnel or an authorized repair
center perform warranty service. Performing unauthorized service on a device that is within
warranty may void the warranty.

Electrostatic discharge (ESD)

 

CAUTION Electrostatic discharge (ESD) can damage or destroy electronic
components. Handle static-sensitive components only at static-safe workstation.

CAUTION Assume that all electrical and electronic components of the device are
static-sensitive.

Electrostatic discharge is a sudden current flowing from a charged object to another object or to
ground. Electrostatic charges can accumulate on common items such as foam drinking cups,
cellophane tape, synthetic clothing, untreated foam packaging material, and untreated plastic bags
and work folders, to name only a few.

11



Electronic components and assemblies, if not properly protected against ESD, can be permanently
damaged or destroyed when near or in contact with electrostatically charged objects. When you
handle components or assemblies that are not in protective bags and you are not sure whether
they are static-sensitive, assume that they are static-sensitive and handle them accordingly.

• Perform all service procedures in a static-protected environment. Always use techniques and
equipment designed to protect personnel and equipment from electrostatic discharge.

• Remove static-sensitive components and assemblies from their static-shielding bags only at
static-safe workstations—a properly grounded table and grounded floor mat—and only when
you are wearing a grounded wrist strap (with a resistor of at least 1 megohm in series) or other
grounding device.

• Use only grounded tools when inserting, adjusting, or removing static-sensitive components
and assemblies.

• Remove or insert static-sensitive components and assemblies only with device power turned
off.

• Insert and seal static-sensitive components and assemblies into their original static-shielding
bags before removing them from static-protected areas.

• Always test your ground strap, bench mat, conductive work surface, and ground cord before
removing components and assemblies from their protective bags and before beginning any
disassembly or assembly procedures.
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Overview
 

Purpose and scope
This service manual is a reference for periodic preventive maintenance and corrective service
procedures for the Welch Allyn Spot Vital Signs 4400 device. It is intended for use only by trained
and qualified service personnel.

Corrective service is supported to the level of field-replaceable units. These include circuit-board
assemblies and some subassemblies, case parts, and other parts.

WARNING When performing a service procedure, follow the instructions exactly
as presented in this manual. Failure to do so could damage the device, invalidate
the product warranty, and lead to serious personal injury.

CAUTION No component-level repair of circuit boards and subassemblies is
supported. Use only the repair procedures described in this manual.

Find instructions for functional testing and performance verification in the Welch Allyn Service Tool
help files.

This manual applies only to this device. For servicing of any other vital signs device, see the service
manual for the specific device.

Service work not described in this manual must be performed by qualified service personnel at the
factory or at an authorized Welch Allyn service center.

Related documents
When using this manual, refer to the following:

• Welch Allyn Spot Vital Signs 4400 Instructions for use (on the user documentation CD)

• Welch Allyn Service Tool:

https://www.hillrom.com/en/services/welch-allyn-service-tool/

• Welch Allyn Service Tool Installation and configuration guide:

https://www.hillrom.com/en/services/welch-allyn-service-tool/

• Welch Allyn 9600 Plus Calibration Tester Directions for use

https://assets.hillrom.com/is/content/hillrom/80020333LITPDFpdf

• Hillrom website: hillrom.com
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Technical support services
Welch Allyn offers the following technical support services:

• Telephone support

• Loaner equipment

• Service agreements

• Service training

• Replacement service parts

• Product service

For information on any of these services, go to this site:

https://www.hillrom.com/en/services/

Service loaners
For warranty or non-warranty repairs not covered under a support agreement, loaners are available
for a nominal charge, subject to availability. Payment is required prior to shipment for all loaners
not covered under a support agreement. The loaner fee can be found on the Welch Allyn loaner
price list.

Welch Allyn Service Centers that provide repair service for this product can, on request, loan a
device for use while the device is being repaired. Loaned devices are provided free of charge for
products repaired while under a support agreement that includes a free loaner provision.

Service options

SmartCare™ services for maintenance and repair
While product warranties provide basic assurance of Welch Allyn hardware quality, they may not
include the full range of services and support you need. Welch Allyn offers premium service and
support through our SmartCare program. Whether you service your own devices and require a
minimum of support or rely on us to service your device, Welch Allyn provides a program that will
meet your needs. For more information visit our web site at https://www.hillrom.com/en/services/
or call your sales representative.

Warranty service
All repairs on products under warranty must be performed or approved by Welch Allyn. Refer all
warranty service to Welch Allyn Product Service or another authorized Welch Allyn Service Center.
Obtain a Return Material Authorization (RMA) number for all returns to Welch Allyn Product Service
from our website: https://www.welchallyn.com/en/service-support/submit-a-repair.html.

CAUTION Unauthorized repairs will void the product warranty.

Non-warranty service
Welch Allyn Product Service Centers and Authorized Service Providers support non-warranty
repairs. Contact any Welch Allyn regional service center for pricing and service options.

Welch Allyn offers modular repair parts for sale to support non-warranty service. This service must
be performed only by qualified end-user biomedical/clinical engineers using this service manual.
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Service training is available from Welch Allyn for biomedical/clinical engineers. For information, go
to this site:

https://www.hillrom.com/en/knowledge/technical-training/

Repairs
A Welch Allyn Service Center or Authorized Service Provider must perform all repairs on products
under warranty unless you are a properly certified technician that has successfully completed a
Welch Allyn Technical Training course. More information on Technical Training can be obtained
from your sales representative or by visiting https://www.hillrom.com/en/knowledge/technical-
training/.

CAUTION Unauthorized repairs will void the product warranty.

Qualified service personnel or a Welch Allyn Service Center should repair products out of warranty.

If you are advised to return a product to Welch Allyn for repair or routine maintenance, schedule
the repair with the service center nearest you.

Welch Allyn Technical Support

If you have a problem with the device that you cannot resolve, call the Welch Allyn Technical
Support Center nearest you for assistance. A representative will assist you in troubleshooting the
problem and will make every effort to solve the problem over the phone, potentially avoiding an
unnecessary return.

If your product requires warranty, extended warranty, or non-warranty repair service, a Welch Allyn
Technical Support representative will record all necessary information to issue an RMA number. The
support representative will provide you with the address of the Welch Allyn Service Center to send
your device to.

Technical support is available during local business hours.

Returning products
When returning a product to Welch Allyn for service, ensure that you have the following
information:

• Product name, model number, and serial number. This information may be found on the
product and serial number labels on the back housing.

• A complete return shipping address.
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• A contact name and phone number.

• Any special shipping instructions.

• A purchase-order number or credit-card number if the product is not covered by a warranty.

• A full description of the problem or service request.

1. Obtain an RMA number. Either contact Welch Allyn and request an RMA number or visit us on
the web:

https://www.hillrom.com/en/services/.

NOTE Welch Allyn does not accept returned products without an
RMA.

2. Ship the device to Welch Allyn, observing these packing guidelines:

a. Remove from the package the battery, all hoses, connectors, cables, sensors, power cords,
and other ancillary products and equipment, except those items that might be associated
with the problem.

Recommendations for returning Lithium-ion batteries

• Use ground transportation to return batteries.

• If returning multiple batteries, package each battery individually.

• Do not consolidate multiple batteries in a single package.

• Use packaging provided by Welch Allyn or the battery manufacturer.

• Do not pack a defective battery in checked or carry-on baggage if traveling by air.

Packaging

• If you return the battery with the device, remove the battery, seal the battery in an
antistatic plastic bag, and place the battery in the position reserved for the battery near
the device in the original shipping carton.

• If you return the battery separately, package the battery in the replacement battery’s
plastic bag and shipping box.

If the original shipping carton or replacement battery shipping box is unavailable, consult
the manufacturer website for information about shipping Lithium-ion batteries.

WARNING Safety risk. Do not ship any battery that has been
physically damaged or shows signs of leakage unless you
receive specific instructions which meet the requirements for
the shipment of Lithium-ion batteries. Dispose of damaged or
leaking batteries in an environmentally safe manner consistent
with local regulations.

NOTE In the United States, the applicable regulations can be
found in the Code of Federal Regulations (CFR). Refer to 49 CFR
173.185 for shipping Lithium-ion batteries by air or ground. Use
49 CFR 172.102 sections A54 and A101 to find the special
provisions for shipping Lithium-ion batteries.

b. Clean the device.
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NOTE To ensure safe receipt of your device by the service
center and to expedite processing and return of the device to
you, thoroughly clean all residues from the device before
you ship it to Welch Allyn.

If a returned device is found to be contaminated with bodily
fluids, it will be returned at the owner’s expense. United States
federal regulations prohibit the processing of any device
contaminated with blood-borne pathogens. Welch Allyn
thoroughly cleans all returned devices on receipt, but any
device that cannot be adequately cleaned cannot be repaired.

c. Put the device, enclosed in a plastic bag with a packing list, into the original shipping
carton with the original packing materials or into another appropriate shipping carton.

d. Write the Welch Allyn RMA number with the Welch Allyn address on the outside of the
shipping carton.

Recommended service intervals
To confirm that the device is functioning within design specifications, perform periodic service as
indicated in the following table. The device has no specific use time limitation. The device may
remain in service until repair is required or operation indicates that it is out of calibration.

Component Service interval Service procedure

NIBP module Annually Basic functional verification

SpO2 module Annually Basic functional verification

SureTemp Plus Annually Basic functional verification

Battery Semi-annually1 Replace the battery

1 Battery performance is a function of clinical use and charge/discharge patterns. Welch Allyn recommends
replacing the battery after six months or when its remaining capacity no longer meets workflow
requirements.

Customers who have the Standard unlicensed edition of the Welch Allyn Service Tool can perform
the basic functional verification and calibration procedures referenced in the table by following the
instructions in this manual. If you have the Gold edition of the service tool, use the tool to perform
a complete functional verification and calibration of the device in lieu of performing the basic tests.

Perform a complete functional verification and calibration of the device whenever any of the
following conditions exists:

• The device does not meet specifications (based on the basic functional verification)

• The device has been dropped or otherwise damaged

• The device is malfunctioning

• The case has been opened

• An internal part has been replaced (battery excluded)
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NOTE For instructions on using the Gold edition, see the Service Tool help files.

Maintenance
For device maintenance information, see “Maintenance and service” in the device’s Instructions for
use. This section covers the following topics:

• Perform periodic checks

• Replace the device battery

• Cleaning requirements

NOTE Service-related cleaning is addressed in the service manual as well.

The Welch Allyn Service Tool
The Welch Allyn Service Tool is available in the following editions:

• Standard unlicensed: Accompanies your device. Download from https://www.hillrom.com/
en/services/welch-allyn-service-tool/.

• Gold: Required to perform complete functional verification and calibration. This edition
requires an additional license. For more information about acquiring this license, contact
Welch Allyn.

NOTE To qualify for the Gold license, you must attend the Welch
Allyn technical training course or complete online training for the
device.

Clinicians and technical service personnel can use the service tool to manage and maintain
supported Welch Allyn products. You can use the service tool to do the following:

• Review device information. When connected to the device, the service tool lists installed
modules, installed firmware and hardware versions, warranty and repair information, status,
and usage history.

• Receive notifications when periodic maintenance is needed. The service tool can help you
manage and maintain your entire inventory of supported Welch Allyn products. Through the
remote service function, the service tool can connect to Welch Allyn Customer Service. With
this functionality you can automatically receive firmware updates and feature upgrades for
your supported products, including software upgrades for the service tool.

• Install updates and upgrades. The service tool can read the firmware version for each
module and check for available updates or upgrades.

NOTE For the Welch Allyn Service Tool to support updates and
upgrades, adjust your firewall settings to permit access for IP
address 169.254.10.10 (the local feed server for the software
upgrade process).

• Create a work list. The work list provides information about service actions—referred to as
work orders—that are waiting for you to perform on your maintained devices. Work orders
may include periodic calibrations, upgrades, or license installations.

• Schedule periodic maintenance. You can use the service tool to set the service interval for
each maintained device.
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• View and save logs. You can download and save log files from the device for analysis to help
diagnose and identify reported issues.

• Create user accounts. Administrators can create user accounts and set permission levels to
control access to the features, allowing one group to perform administrative tasks and another
to perform service tasks. Restricting access prevents the service tool from being used to make
unauthorized changes on a connected device.

• Perform functional verification and calibration. The service tool can check any device
requiring calibration and, if necessary, calibrate the device to match the design specifications.
This feature is not supported for all products and requires the service tool, Gold edition, for
each supported product.

• Recover devices. In the rare case where a device can no longer boot because of corrupted
firmware, the service tool can connect the device to Welch Allyn Technical Support to reinstall
the firmware.

• Extensible. The service tool software accepts new plug-ins to support future Welch Allyn
products.

Some of these features are enabled for any user (Standard unlicensed edition). Others require
special user account privileges or a Welch Allyn service contract (Gold edition). If you require gold-
level support for a Welch Allyn product, please contact Welch Allyn technical support.

Battery performance

About the batteries
The device uses a rechargeable, 2-cell, Lithium-ion smart battery. Internal circuitry enables the
battery to report its condition to the device. The device displays the battery status via the LED
power indicator, icons on the screen, and status messages appearing in the Device Status area of
the display.

The battery status indicator on the device displays the remaining charge. Battery information may
be collected using the service tool.

New batteries are shipped from the manufacturer with a 30 percent charge to extend shelf life.
After installing a new battery in the device, you must plug the device into AC power to wake up the
battery. If AC power is not applied to the device, the new battery appears discharged.

The Device Status area displays a low-battery notification when 30 minutes of power remain and
again when 5 minutes of power remain. The 30-minute notification is dismissable by the user, and
all functions of the device remain available. The 5-minute notification is not dismissable, and
prevents acquiring vitals measurements or performing any other function until the device is
plugged in to AC power.

If AC power is not applied to the device after it triggers the 5-minute notification, the device will
shut down at or close to 0 minutes of remaining battery charge.

Battery charging is provided by the device’s internal power supply. The power reserve threshold is
determined by the device's software.

For a complete list of battery specifications, see the device’s Instructions for use.

Follow best practices to extend the life of the battery
The following practices help to extend the life of the battery and the device.
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WARNING Safety risk. When handling and storing Lithium-ion batteries: Avoid
mechanical or electrical abuse. Batteries may explode or cause burns if
disassembled, crushed, or exposed to fire or high temperatures. Do not short or
install with incorrect polarity.

• Whenever possible, keep the device plugged in to charge the battery.

• Remove the battery when storing the device for an extended amount of time.

• Replace batteries that trigger a low battery status message when fully charged.

• Do not use damaged or leaking batteries.

• Store batteries with a 30 to 50 percent charge.

• Store batteries within the temperature range indicated for each period:
○ For storage less than 30 days: Maintain temperature between –4 °F and 122 °F (–20 °C and

50 °C).
○ For storage between 30 days and 90 days: Maintain temperature between –4 °F and 104 °F

(–20 °C and 40 °C).
○ For storage more than 90 days up to 2 years: Maintain temperature between –4 °F and 95

°F (–20 °C and 35 °C).

• Recycle batteries where ever possible. In the United States call 1-877-723-1297 for information
about recycling your Lithium-ion battery or go to the Call2Recycle website at https://
www.call2recycle.org for additional information.

• When recycling is not an option, dispose of batteries in an environmentally safe manner
consistent with local regulations.

Factors affecting battery operating time
The following table presents settings and conditions that affect the battery operating time and
recommendations to maximize battery life.

Setting / Condition Recommended setting

Display brightness setting 5

Sleep mode setting 1 minute

Automatic power-down setting 15 minutes
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Controls, indicators, and connectors
 

NOTE Your model might not contain all of these features.

Front-Left view

No. Feature Description

1 LCD screen 7" color touchscreen provides a graphical user interface

2 Thermometry probe well Houses the SureTemp probe on the device

3 Battery charge and power-up status
indicator The LED indicates the charging and power-up status when

connected to AC power:
• Green: The battery is charged
• Amber: The battery is charging
• Flashing: The device is powering up
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No. Feature Description

4 Power button
Blue button on lower-left corner of the device:

• Powers on the device
• Provides power options for the device
• Wakes up the device from Sleep mode

Back-Bottom-Left view

No. Feature Description

1 Battery compartment (behind cover) Houses the battery (captive screw secures cover to device)

2 NIBP Connects the NIBP hose to the device

3 USB client port Provides a connection to an external computer for testing,
software upgrades, and connectivity

4 Power connection Connects the power adapter to the device

5 USB port Connects a USB drive to the device for saving log files

6 Thermometry Connects the SureTemp probe to the device

7 SpO2 Connects the SpO2 sensor to the device
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Advanced settings
 

Advanced settings provide access to device preferences and service options. The following primary
tabs are accessible in Advanced settings:

• General. Settings for system language as well as date and time, plus open source software
disclosure.

• Parameters. Settings for physiological parameters, additional patient data, and averaging.

• Service. Settings and features that support installation and on-device troubleshooting.

Access Advanced settings
NOTE You cannot access Advanced settings if sensors or error conditions are
active or if vital sign measurements are displayed.

1. From the Home tab, touch the Settings tab.

2. Touch the Advanced vertical tab.

3. Touch Advanced settings.

The device sounds two beeps and the General tab appears.

4. Configure device settings, physiological parameters, and perform service tasks as needed.

NOTE Service tasks and how to do them are detailed in this section.

5. When you are finished, touch Exit.

The Home tab appears.

General tab

Specify the language
1. From the Home tab, touch Settings > Advanced > Advanced settings.

The General tab appears.

2. Select the preferred language.

3. Optionally, configure other advanced settings.

4. When you are finished configuring advanced settings, touch Exit to return to the Home tab.
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Specify date and time settings
1. In Advanced settings, touch the General > Date / Time tabs.

2. Specify settings.
Setting Action/Description

Time zone Select the appropriate UTC time zone from the
drop-down.

Date format Select a format for displaying the date.

Enable daylight saving time Check this box to automatically update the device
time when Daylight Saving Time starts and ends.

3. Optionally, configure other advanced settings.

4. When you are finished configuring advanced settings, touch Exit to return to the Home tab.

Specify power management settings
1. In Advanced settings, touch the General > Power management tabs.

2. Specify settings.
Setting Action/Description

Allow sleep mode Check this box to enable the device to
automatically enter sleep mode after a period of
inactivity. Then, set the Automatic sleep timeout
period (1-30 minutes).

Allow automatic shutdown Check this box to enable the device to
automatically shut down after a period of inactivity.
Then, specify the Automatic shutodwn timeout
(1-30 minutes).

3. Optionally, configure other advanced settings.

4. When you are finished configuring advanced settings, touch Exit to return to the Home tab.

Review the open source software disclosure
1. In Advanced settings, touch the General > Open Source tabs.

2. Read Welch Allyn's disclosure about its use of "free" or "open source" software.

3. Optionally, configure other advanced settings.

4. When you are finished configuring advanced settings, touch Exit to return to the Home tab.

Parameters tab

Specify advanced NIBP settings
1. In Advanced settings, touch the Parameters > NIBP tabs.

2. Specify settings.
Setting Action/Description

Default view Select default primary and secondary views.

Unit of measure Select the NIBP unit of measure for display.
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Algorithm default Select the default algorithm used to determine
NIBP measurements.

Cuff inflation target If the default algorithm is set to Step, enter a default
cuff inflation pressure for each type of patient.

3. Optionally, configure other advanced settings.

4. When you are finished configuring advanced settings, touch Exit to return to the Home tab.

Specify advanced temperature settings
1. In Advanced settings, touch the Parameters > Temperature tabs.

2. Specify settings.
Setting Action/Description

Default temperature site Select a location for the default temperature site.

Unit of measure Select primary units of measure for the temperature
display on the Home tab.

Display temperature conversion Enable to display primary units of measure and
secondary units of measure for the temperature
display on the Home tab.

3. Optionally, configure other advanced settings.

4. When you are finished configuring advanced settings, touch Exit to return to the Home tab.

Specify additional parameters
1. In Advanced settings, touch the Parameters > Additional parameters tabs.

2. Select the additional parameters you wish to display on the Home tab.

NOTE BMI will be automatically calculated based on the patient's
height and weight.

3. If you selected the options Display height and Display weight, then select the preferred unit
of measurement for each parameter.

4. Optionally, configure other advanced settings.

5. When you are finished configuring advanced settings, touch Exit to return to the Home tab.

Specify advanced program interval settings
1. In Advanced settings, touch the Parameters > Averaging tabs.

2. Specify settings.
Setting Action/Description

Readings to average The averaging program supports up to 6 readings.
Select which readings in the series to use for the
averaged measurement (and, as a result, the
number of readings to average).

Delay to start Specify the amount of time to wait after the
clinician touches START AVERAGE and before the
first reading starts.

Time between Specify the amount of time to wait between each
reading.
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Keep if + or - Specify the range that the program uses as criteria
to accept or reject readings and establish the
baseline reading.

The configured settings are displayed in the Summary section.

3. Optionally, configure other advanced settings.

4. When you are finished configuring advanced settings, touch Exit to return to the Home tab.

Service tab

Perform general device service
You can calibrate the touchscreen and check the functionality of NIBP accuracy on the device
without use of the Welch Allyn Service Tool.

1. In Advanced settings, touch the Service > General tabs.

2. To verify the NIBP pressure valve accuracy, touch Close Valve.

The pressure displays in the NIBP Pressure Verification field.

To stop the accuracy test, touch Open Valve or navigate away from the screen.

3. To calibrate your touchscreen, touch Start in the right pane and follow the onscreen prompts.

The Home tab appears when calibration is complete.

Save service logs to a USB flash drive
This procedure enables you to save the last 14 active log files to a USB flash drive.

1. In Advanced settings, touch the Service > Log file tabs.

2. Connect a flash drive to the USB port.

3. Touch Save to USB.

Copies of the service log files are saved to the drive. You may remove the flash drive from the
device.

Restore factory default settings

NOTE This process does not restore the device to a custom configuration
provided at delivery. Instead, it deletes all custom configuration data and restores
factory default settings.

1. In Advanced settings, touch the Service > System tabs.

2. Touch Reset.

3. Click OK to confirm.

The device reboots and the default factory settings are restored.
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Power-up sequence
 

Overview

The system performs a power-on self test (POST) of the software and internal hardware each time
the device is powered on. Specific tests performed include the following:

• CVC-PIC tests

• LED power tests

• eMMC (memory) tests

• EEPROM tests

If all tests are successful, the system completes power up, the Home tab appears, and the system is
ready for operation.

If the self-check fails, an error message and an error code appear in the system status area at the
top of the screen to aid service personnel and engineers in diagnosing the problem. If a fault that
could adversely affect the product is detected, the system enters a safe mode and stops all vitals

functions. The system remains in safe mode until it is turned off by pressing  or until the device
shuts down automatically after a period of inactivity.

To perform the POST:

1. Disconnect any patient cables connected to the system.

2. Insert a fully charged battery into the system.

3. Power up the device and confirm the following:

a. The buzzer generates a sound.

b. A startup screen appears briefly and then disappears.

c. The power button flashes until the UI is ready.

d. The Home tab appears.

Power
The Power button, located on the lower-left corner of the device, performs multiple functions:

• Powers up the device

• Wakes the device from Sleep mode

• Opens a pop-up dialog with controls to power down, enter Sleep mode, or cancel
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CAUTION Do not use a long press of the Power button to power down the
device when it is functioning normally. You will lose patient data and
configuration settings. Touch the Settings > Device tab to power down the
device.

The LED in the center of the power plug symbol indicates the battery charging status.

• Green indicates that AC power is present and that the battery is fully charged.

• Amber indicates that AC power is present and that the battery is charging.

Power up the device
The device runs a brief diagnostic self-test each time it powers up. If an issue occurs, the error
appears in the Status area.

WARNING To ensure patient safety, listen for an audible indicator and watch for
visual messages at power-up at least once daily. Correct any system errors before
using the device. In addition to the audible indicator, the screen Status area
displays icons and messages that help you to distinguish any actions, if needed.

WARNING Always observe the device during power-up. If any display fails to
illuminate properly, or if a system fault code or message displays, inform qualified
service personnel immediately, or call your nearest Welch Allyn Customer Service
or Technical Support facility. Do not use the device until the problem is corrected.

CAUTION Always use the device with an adequately charged and properly
functioning battery.

CAUTION Use only a Class I (grounded) AC power cord to charge the battery for
this device.

Press  to power up the device.

The power LED flashes until the device displays the Hillrom logo and a power-up tone sounds.
On initial power-up, the device prompts you to set the language, date, and time.

Power down the device
When the device is functioning normally, use this method to power down. This method retains
patient measurements in the device memory for a maximum of 24 hours. Saved measurements are
available for recall or electronic transmission to the network. This method also ensures that any
configuration settings you have changed and saved will be maintained at the next startup.

1. Do one of the following to access the power menu:

• Briefly press .
• Touch Settings > Device > Power down.

If there is no system message, a dialog box appears with options to Power down, Sleep, and
Cancel.

2. Touch Power down.

The device clears all data onscreen and performs a complete software shutdown.
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Reset the device
Reset the device only when the device becomes unresponsive. Patient data and configuration
settings will be cleared from device memory.

1. Press and hold , located on the lower-left corner of the device.

2. If there is a prompt with options to Power down, Sleep, or Cancel, continue to press  for
several seconds.

The device powers down. Patient data and configuration settings are cleared from device
memory.

3. Press  to power up the device.
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Disassembly and repair
 

These procedures provide instructions for device disassembly and board removal, as well as
component replacement and reassembly.

Each part’s disassembly instructions might include one or both of the following:

• Reassembly notes: This subsection contains information specific to reassembly. At a
minimum, these notes indicate whether or not reassembly is the reverse of disassembly. The
notes also list service kits of replacement parts where applicable.

• When replacing the component: This subsection contains additional instructions related to
installing a new option or replacement part.

Each disassembly step includes drawings that illustrate the components to be removed. The
reassembly notes could be as short as one or two lines when reassembly is the reverse of
disassembly. When reassembly is more complicated, these notes alert you to any special care
required to complete the repair or installation and sometimes introduce separate reassembly
instructions. Line drawings appear in the reassembly notes only when they differ from the drawings
in the disassembly instructions.

WARNING Electrical shock hazard. Disconnect AC power before opening the
device. Disconnect and remove the battery before proceeding with disassembly.
Failure to do this can cause serious personal injury and damage to the device.

WARNING Risk of fire, explosion and burns. Do not short-circuit, crush, incinerate,
or disassemble the battery pack.

WARNING Safety risk. Do not attempt to service the device when the device is
connected to a patient.

CAUTION Before disassembling the device or installing options, disconnect the
patient from the device, power down the device, disconnect the AC power cord
and any attached accessories (for example, SpO2 sensors, blood pressure hoses
and cuffs, and temperature probes) from the device.

CAUTION If your device is configured with a SureTemp module, remove the
probe well before disassembly.

CAUTION Perform all repair procedures at a static-protected station.

CAUTION When the device case is opened, regard all parts as extremely fragile.
Execute all procedure steps with care and precision.

CAUTION Observe screw torque specifications, especially with screws that secure
directly into plastic standoffs.
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CAUTION To avoid mismatching screws and holes, keep the screws for each
piece with that piece as you remove modules and circuit assemblies. It is possible
to mistakenly install machine screws in locations intended for plastite screws.
Plastite screws have a Torx-pan head.

Required tools and equipment
• Phillips #0 screwdriver

• Phillips #1 screwdriver

• T-10 Torx screwdriver

• 3/8" socket

Torque value table
Use this table to determine how much torque to apply to screws by type and location when
reassembling the device.

Description Torque specification Bit type Where used

NUT, 5/16-32. THIN PROFILE 3.0 +/-0.5 in-lbs 3/8" hex Power harness

SCR,4-20X.31 PLASTITE PH TORX 4.5 +/-0.5 in-lbs T-10 Torx SpO2 insert - Rear housing

SCR,4-20X.31 PLASTITE PH TORX 4.5 +/-0.5 in-lbs T-10 Torx Pneumatic & Sensor assy

SCREW 4-40 .250 PAN PHILLIPS
STEEL ZINC

4.5 +/-0.5 in-lbs #0 Phillips SpO2 sensor & SpO2 adapter
PCBA

SCREW, M4 X 10 PAN HEAD W
NYLOC

7.5 +/-0.5 in-lbs #1 Phillips Rear - Front housings

SCR, M4 PAN HD, PHD,
SHOULDER

4.5 +/-0.5 in-lbs #1 Phillips Battery Door

SCR, 4-20X.31 PLASTITE PH TORX 4.5 +/-0.5 in-lbs T-10 Torx Pneumatic & Sensor assy

SCREW, M4 X 10 PAN HEAD W
NYLOC

7.5 +/-0.5 in-lbs #1 Phillips Rear and Front housings

Connector types
Disassembly and repair procedures require that you disconnect and reconnect the following
connector types inside the device:

• Locking (squeeze-release): Locking connectors use a latching mechanism to prevent
accidental disconnection during assembly and use. The latch is located on one end of a tab so
it may flex and lock into place when coupled with its matching connector. The tab provides a
lever to release the latch. Some connectors have multiple latches that require you to press
multiple tabs to release.
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To remove a locking connector, squeeze the tab(s) to release the latch(es) and remove the
cable.

To connect a locking connector, push the mating pieces together until the latch(es) lock in
place.

• Friction: Friction connectors use a spring mechanism to create friction between the contacts.

To remove a pressure connector, grasp each connector mating half and pull the halves apart.

CAUTION Do not use excessive force to disconnect the
connector. Excessive force may result in pulling the mounted
connector off the circuit board.

To connect a friction connector, grasp each connector mating half and insert one half into the
other.

• ZIF (zero insertion force): The device uses flex cables and ZIF flex cable connectors. Flex
cables and ZIF connectors require special care when handling.

ZIF connectors use a sliding outer piece that latches and unlatches to secure and release the
flex cable. ZIF cables cannot be successfully connected or disconnected without properly
unlatching and latching the sliding outer piece.
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CAUTION Do not use excessive force when releasing pressure on
the connector. Excessive force may result in breaking the sliding
outer piece.

To remove a ZIF connector

CAUTION Remove a flex cable only after the ZIF latch is open.

1. Using a suitable tool (for example, a paper clip, small flat-head screwdriver, or needle-nose
pliers), slide the latching piece of the connector away from the connector body.

2. Remove the cable.

To connect a ZIF connector

1. Slide the latching piece of the connector away from the connector body.

2. Insert the flex cable into the connector. This may require using a suitable tool to keep the
latching piece elevated.

3. Slide the latching piece toward the connector body until it locks into place.

• FHY connector (Self-Lock mechanism): The device uses Self-Lock mechanism cable
connectors.

A Self-Lock mechanism enables the cover to close by one-touch operation.
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CAUTION Do not use excessive force when releasing pressure on
the connector. Excessive force may result in breaking the locking
mechnanism.

To remove a Self-Lock mechanism

CAUTION Remove a flex cable only after the FHY connector latch
is open.

1. Lift the latching piece of the connector up off the the connector body.

2. Remove the cable.

To connect a Self-Lock mechanism

1. Lift the latching piece of the connector up off from the connector body.

2. Insert the flex cable into the connector.

3. Push down on the latching piece connector until it locks into place.

Disassembly overview
The following flow chart provides an overview of the complete disassembly of the device. Most
disassembly activities require that you complete a subset of the steps detailed here. The flow chart
indicates the steps which must be completed in sequence to remove a particular component.
Because a different sequence of preliminary steps is required to remove certain components, you
should use this flow chart as a reference at the start of every disassembly and component
replacement procedure.
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NOTE After performing any of these procedures and before returning the device
to service, you must use the service tool, Gold edition, to complete the full suite of
functional tests to ensure that all systems are operating within the design
specifications. For more information about these tests and the service tool, see
“Functional verification and calibration.” If you do not have the service tool, you
can download it from https://www.hillrom.com/en/services/welch-allyn-service-
tool/.

Power down the device
When the device is functioning normally, use this method to power down. This method retains
patient measurements in the device memory for a maximum of 24 hours. Saved measurements are
available for recall or electronic transmission to the network. This method also ensures that any
configuration settings you have changed and saved will be maintained at the next startup.

1. Do one of the following to access the power menu:

• Briefly press .
• Touch Settings > Device > Power down.

If there is no system message, a dialog box appears with options to Power down, Sleep, and
Cancel.

2. Touch Power down.

The device clears all data onscreen and performs a complete software shutdown.
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Remove the device from the Mobile stand
1. Disconnect the power cord from the wall.

2. Disconnect the power supply and communication cables from the device.

3. Remove the 4 Phillips screws from the back of the mount.

4. Grasp the device securely and remove the device from the mount.

Reassembly notes

NOTE Remounting the device is the reverse of removal.

Remove the device from the 4400-DST Desk stand
1. Disconnect the power cord from the wall.

2. Disconnect the power supply and communication cables from the device.

3. Remove the 4 Phillips screws from the back of the mount.
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4. Grasp the device securely and remove the device from the mount.

Reassembly notes

NOTE Remounting the device is the reverse of removal.

Remove the device from the 77794-M4400 or
77794-2M4400 Integrated Wall Panel

1. Disconnect the power cord from the wall.

2. Disconnect the power supply and communication cables from the device.

3. Detach the device from tilt tensioner of the wall board.

a. Loosen the screw that secures the device to the tilt tensioner.

b. Firmly grasp the device with both hands and pull up to remove the device from the
bottom and top mounting hooks of the wall-mount bracket.
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4. Grasp the device securely and remove the 4 Phillips screws from the back of the device and set
the bracket aside for remounting.

Reassembly notes
To remount the device:

1. Attach the device bracket to the device with the 4 Phillips screws.
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2. Mount the device onto the tilt tensioner of the wall board.

a. Attach the bottom of the device bracket onto the tilt tensioner so that the device hooks
into place as shown in the illustration.

b. Attach the top of the device bracket onto the tilt tensioner so that the device hooks into
place as shown in the illustration. Apply some pressure to the top of the device and push
down until the device slides down into the hook of the top tilt tensioner.

c. Tighten the screw to secure the device bracket to the tilt tensioner.

Exploded view diagram
The drawing below shows individual components of the device and their relationships to one
another.
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Remove the battery
1. Place the unit face down on the table as shown.

2. Loosen the captive Phillips screw to remove the battery door.
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3. Squeeze the locking tab to disconnect the battery and remove the battery.

Reassembly notes

WARNING Defective batteries can damage the device. If the battery shows any
signs of damage or cracking, it must be replaced immediately and only with a
battery provided by Welch Allyn.

Kit items:

• BATT22, BATTERY PACK

• 107212, SRV KIT, BATTERY FOAM

NOTE Reassembly is the reverse of disassembly.

Remove the back housing
1. Remove the 9 Phillips screws on the back of the device.
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2. Lift the back housing straight up.

WARNING The main PCA board is not secured to the front housing. Ensure that
you hold the main PCA board in place if you need to carry the device or tip the
device onto its end.

Reassembly notes
Kit item:

• 107214, SRV KIT, REAR HOUSING WITH LABELS

NOTE The back housing is not available for direct purchase. Welch Allyn limits
availability of certain parts to Authorized Service Personnel only. These limitations
are required to maintain product safety or maintain current regulations.

NOTE Reassembly is the reverse of disassembly.

Remove the power harness
1. Using a 3/8" socket, loosen the nut from the power harness barrell, and then remove the nut

and two washers. Set aside to use during reassembly.
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2. Disconnect the power harness from the main PCA board and then carefully remove the power
harness.

Reassembly notes
Kit item:

• 107186, SRV KIT, POWER HARNESS

NOTE Reassembly is the reverse of disassembly.

NOTE Ensure that you install the washers in the correct order. The flat washer
slides onto the barrell first, followed by the locking washer, with the toothed side
pointing toward the communications board.

Remove the SureTemp module
WARNING The main PCA board is not secured to the front housing. Ensure that
you hold the main PCA board in place if you need to carry the device or tip the
device onto its end.

1. With the unit laying flat, reach underneath and grasp the top of the probe well with your
thumb and forefinger. Firmly pull the probe well to remove it from the holder.
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2. Disconnect the ribbon cable from the ZIF connector on the main PCA board.

3. Lift the module out of the housing.

4. If you are replacing only the SureTemp board or the ribbon cable, disconnect the cable from
the board. Set aside the part that will be reused for reassembly.

Reassembly notes
Kit item:

• 107187, SRV KIT, SURETEMP PLUS MODULE, w/o ring
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• 107189, SRV KIT, SURETEMP CABLE

NOTE Reassembly is the reverse of disassembly; however, note the following:

• The SureTemp board rests in two notches on the front housing. Place the module in the notch
near the bottom of the front housing, and the module will align with the notch near the main
PCA board.

• Ensure that you push the cable down into the rubber gasket.

• The SureTemp module will sit loosely in place until you insert the probe well.

Remove the Nonin SpO2 board
Remove the 2 Phillips screws (with washers) that attach the SpO2 board to the SpO2 adapter
board, and then lift the board up to remove.
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Reassembly notes
Kit item:

• 105933, SRV KIT, NONIN SPO2 BOARD

NOTE Reassembly is the reverse of disassembly.

Remove the Nonin SpO2 adapter board
Remove the 2 Phillips screws (with washers) and then press down gently on the main PCA
board while you carefully pull the SpO2 adapter board out of the connectors on the main PCA
board.

Reassembly notes
Kit item:

• 107185, SRV KIT, NONIN SPO2 ADAPTER BOARD

NOTE Reassembly is the reverse of disassembly.

Separate the main PCA board from the front housing
1. Carefully open the latch on the ZIF connector on the main PCA board, and then remove the

power switch flex cable.
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2. Remove the main PCA board from the front housing.

Reassembly notes
Kit item:

• 107184, SRV KIT, MAIN PCA, AND LCD FRAME

NOTE Reassembly is the reverse of disassembly.

Remove the touchscreen and display ribbon cable
separately from the main PCA board

NOTE The touchscreen contains a serial number: TFC-K9700RTWV37TR or TFC-
K9700RTWV55. Removal and Reassembly steps are the same for both serial
numbers, except that the TFC-K9700RTWV37TR serial number has an integrated
(soldered) LCD flex cable.

1. For the TFC-K9700RTWV55 serial number, carefully separate the LCD flex cable from its
connector on the main PCA board by pulling the cable straight up.
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2. Turn over the main PCA board so that the notch on the board faces you.

3. On the side of the main PCA board with the notch, carefully lift the LCD past the tabs, and tilt
the LCD upward.

4. Remove the Gaff tape covering the bale connector and set it aside for reassembly.

5. Carefully lift the bale (locking mechanism) of the LCD flex cable connector on the main PCA
board and remove the LCD.
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Reassembly notes

NOTE When you return the Spot Vital Signs 4400 Extended Care device (home
use model) for service to have the LCD with touchscreen replaced, the 108241 kit
will be used. When you return the Spot Vital Signs 4400 device (professional
model) for service to have the LCD with touchscreen replaced, the 105924 kit will
be used.

Spot Vital Signs 4400 Extended Care kit item:
• 108241, SRV KIT HW A-F, LCD WITH TOUCHSCREEN

Spot Vital Signs 4400 kit item:
• 105924, SRV KIT, LCD WITH TOUCHSCREEN

NOTE Reassembly is not the reverse of disassembly.

NOTE Use the Gaff tape set aside during disassembly to reassemble the LCD.

Attach the touchscreen and display ribbon cable separately to the
main PCA board

NOTE The touchscreen contains a serial number: TFC-K9700RTWV37TR or TFC-
K9700RTWV55. Reassembly steps are the same for both serial numbers, except that
the TFC-K9700RTWV37TR serial number has an integrated (soldered) LCD flex
cable.

Spot Vital Signs 4400 Extended Care kit item:

• 108241, SRV KIT, HW A-F, LCD WITH TOUCHSCREEN

Spot Vital Signs 4400 kit item:

• 105924, SRV KIT, LCD WITH TOUCHSCREEN

1. With the LCD frame facing up, carefully insert the LCD flex cable into the connector.
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2. With two fingers, press down the bale to secure the LCD flex cable.

3. Apply the Gaff tape (removed during disassembly) to the connector bale and the LCD flex.

NOTE Do not allow the tape to touch the board or the ferrite to
touch the end of the flex cable when assembled.

4. For the TFC-K9700RTWV55 serial number, insert the small touchscreen flex cable into the hole
on the main PCA board.
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5. Place the LCD at an angle under the tabs on the flex cable side of the LCD.

6. Lower the LCD into place and carefully move the tabs on the opposite side just enough to
catch and secure the LCD in the frame.

NOTE Ensure that the tabs hold the LCD securely.

7. Turn over the main PCA board.

8. For the TFC-K9700RTWV55 serial number, insert the flex cable into its connector.

Remove the sensor housing
Before you begin, complete the following procedures:
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• Remove the power harness.

• Remove the SureTemp module.

• Separate the main PCA board from the front housing.

1. Turn over the main PCA board and remove the single T-10 Torx screw attaching the sensor
insert to the main PCA board.

2. To disconnect the housing from the pump manifold, hold the black pump manifold with one
hand and tilt the top of the insert away from the main PCA board with the other hand.

Reassembly notes
Kit item:

• 107215, SRV KIT, SENSOR HOUSING W/ PWR HARNESS

NOTE Reassembly is the reverse of disassembly.

Remove the pump assembly
1. Remove the pump manifold from the main PCA board transducers.

2. Pinch and remove the pump assembly connector from the main PCA board.
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3. Turn over the main PCA board and remove 2 T-10 Torx screws.

4. Separate the pump assembly from the main PCA board.

NOTE Reassembly is different from disassembly.
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Attach the pump assembly to the main PCA board
Kit item:

• 105920, PUMP ASSEMBLY AND 2 T-10 TORX SCREWS

1. Place the pump manifold onto the main PCA board transducer. Ensure that the pump
manifold is fully seated on the transducer.

2. Connect the pump assembly connector to the main PCA board.

3. Turn over the main PCA board.

4. Secure the pump assembly to the main PCA board with 2 T-10 Torx screws.

Replace the main PCA board
Replace the main PCA board as needed after removing all other components. Before you begin,
ensure that you have the appropriate replacement kit items:

• 107184, SRV KIT, MAIN PCA, AND LCD FRAME

NOTE After installing a new PCA board, use the Welch Allyn Service Tool, Gold
Edition, to prepare the board for first-time use. This includes programming the
device serial number into the new board and performing an NIBP initialization
during full device functionality. See "Program the main PCA board" and "Initialize
the NIBP board" for more information. After replacing the main PCA board and
completing the full functional check, set the first boot option to Production
Complete using the service tool. This will set the device to prompt you to enter
the language, date and time on first boot. See "Service Tool Spot 4400 Help File"
for more information.
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Remove the SpO2 insert
On the inside of the back housing, remove the 2 Torx screws and then remove the insert.

Reassembly notes
Kit items:

• 107350, SRV KIT, SpO2 INSERT BLANK

• 107351, SRV KIT, SpO2 INSERT Nonin

NOTE Reassembly is the reverse of disassembly.

Remove the bezel from the front housing
Lift the rubber bezel up and over the power switch cable and the bosses on the front housing.

NOTE Reassembly is not the reverse of disassembly.
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Attach the bezel to the front housing
Spot Vital Signs 4400 Extended Care kit items:

• 107183, SRV KIT, LCD BEZEL

• 108202, SRV KIT, FRONT HOUSING W/ POWER SWITCH

Spot Vital Signs 4400 kit items:

• 107183, SRV KIT, LCD BEZEL

• 107213, SRV KIT, FRONT HOUSING W/ POWER SWITCH

1. Lay the bezel over the 6 bosses on the front housing, and thread the power switch flex cable
through the slot in the bezel.

2. Press the bezel down onto the 6 bosses on the front housing.

Remove the SureTemp probe end cap
On the inside of the back housing, remove the end cap by gently pulling outward.

Reassembly notes
Kit item:

• 107354, SRV KIT, PROBE BOX CAP

NOTE Reassembly is the reverse of disassembly.

Service manual Disassembly and repair 57



Disassembly and assembly notes for mobile stands and
power supplies

The following table provides an at-a-glance view of the service kits that are compatible with the
combination of mobile stand and power supply based on the date of manufacture. This section is
divided into four major subsections, defined in the table below.

Section A Spot 4400 devices with a 4400-MBS mobile stand meeting these criteria:
• 4400-MBS mobile stand manufactured before 02/2022* or earlier
• 4400-PS power supply manufactured before 02/2022* or earlier
• Power supply model: MENB1035A1500F02

Section B Spot 4400 devices with a 4400-MBS mobile stand meeting these criteria:
• 4400-MBS mobile stand manufactured after 02/2022* or later
• 4400-PS power supply manufactured after 02/2022* or later
• Power supply model: FW8031M/DT/15

58 Disassembly and repair Welch Allyn® Spot Vital Signs 4400



Section C Spot 4400 devices with a 4400-MBS mobile stand meeting these criteria:
• 4400-MBS mobile stand manufactured before 02/2022* or earlier
• 4400-PS power supply manufactured after 02/2022* or later
• Power supply model: FW8031M/DT/15
• Adapter plate kit REF 411626

Section D Spot 4400 devices with a 4400-MBS mobile stand meeting these criteria:
• 4400-MBS mobile stand manufactured after 02/2022* or later
• 4400-PS power supply manufactured before 02/2022* or earlier
• Power supply model: MENB1035A1500F02

* See the model number and label for further information.

Examine your mobile stand and power supply to determine which subsection you should follow to
complete disassembly and assembly procedures.

Many service kits are backward-compatible and/or interchangeable, while others are compatible
with only one or two of the stand and power supply combinations.

Section A, remove the power supply from the mobile stand
This section applies to Spot 4400 devices with a 4400-MBS mobile stand meeting these criteria:

• 4400-MBS mobile stand manufactured before 02/2022* or earlier

• 4400-PS power supply manufactured before 02/2022* or earlier

• Power supply model: MENB1035A1500F02
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NOTE See the model number and label for further information.

1. Power down the device.

2. Disconnect the power cable from the device and disconnect the power cord from the wall.

3. With one hand holding the power supply, remove the 2 Phillips screws that attach the power
supply to the bracket.

NOTE Set the screws aside for reassembly.

4. Remove the power supply unit.

Recycle or dispose of the power supply unit in an environmentally safe manner consistent with
local regulations.

Section A, attach the power supply to the stand
This section applies to Spot 4400 devices with a 4400-MBS mobile stand meeting these criteria:

• 4400-MBS mobile stand manufactured before 02/2022* or earlier

• 4400-PS power supply manufactured before 02/2022* or earlier

• Power supply model: MENB1035A1500F02
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NOTE See the model number and label for further information.

Kit item:

• 4400-PS, SRV KIT, POWER SUPPLY

1. Ensure that the side with the screw holes is facing upward, and then insert the power supply
socket into the support frame.

2. Holding the power supply unit snugly to the frame, attach the power supply to the bracket
using the 2 Phillips screws.

3. Thread the power cable from the power supply through one of the spaces next to the pole to
reach the device, and then connect the power cable to the device.

4. Connect the power cord to the mains outlet.

5. Power up the device.

Section B, remove the power supply from the mobile stand
This section applies to Spot 4400 devices with a 4400-MBS mobile stand meeting these criteria:

• 4400-MBS mobile stand manufactured after 02/2022* or later

• 4400-PS power supply manufactured after 02/2022* or later

• Power supply model: FW8031M/DT/15
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NOTE See the model number and label for further information.

1. Power down the device.

2. Disconnect the power cable from the device and disconnect the power cord from the wall.

3. With one hand holding the power supply, remove the 2 Phillips screws that attach the power
supply to the bracket.

NOTE Set the screws aside for reassembly.

4. Remove the power supply unit.

Recycle or dispose of the power supply unit in an environmentally safe manner consistent with
local regulations.

Section B, attach the power supply to the stand
This section applies to Spot 4400 devices with a 4400-MBS mobile stand meeting these criteria:

• 4400-MBS mobile stand manufactured after 02/2022* or later

• 4400-PS power supply manufactured after 02/2022* or later

• Power supply model: FW8031M/DT/15
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NOTE See the model number and label for further information.

Kit item:

• 4400-PS, SRV KIT, POWER SUPPLY

1. Holding the power supply unit snugly to the support bracket, attach the power supply to the
bracket using the 2 Phillips screws.

2. Thread the power cable from the power supply through one of the spaces next to the pole to
reach the device, and then connect the power cable to the device.

3. Connect the power cord to the mains outlet.

4. Power up the device.

Section C, remove the power supply from the mobile stand
This section applies to Spot 4400 devices with a 4400-MBS mobile stand meeting these criteria:

• 4400-MBS mobile stand manufactured before 02/2022* or earlier

• 4400-PS power supply manufactured after 02/2022* or later

• Power supply model: FW8031M/DT/15
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NOTE See the model number and label for further information.

1. Power down the device.

2. Disconnect the power cable from the device and disconnect the power cord from the wall.

3. With one hand holding the power supply, remove the 2 Phillips screws that attach the power
supply to the bracket. With the other hand, hold the adapter plate and the well nuts.

NOTE Set the screws, adapter plate, and well nuts aside for
reassembly.

4. Remove the power supply unit.

Recycle or dispose of the power supply unit in an environmentally safe manner consistent with
local regulations.

Section C, attach the power supply to the stand
This section applies to Spot 4400 devices with a 4400-MBS mobile stand meeting these criteria:

• 4400-MBS mobile stand manufactured before 02/2022* or sooner

• 4400-PS power supply manufactured after 02/2022* or later

• Power supply model: FW8031M/DT/15
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NOTE See the model number and label for further information. To
install the new power supply onto an existing stand, you need to
use the adapter plate kit REF 411626.

Kit item:

• 4400-PS, SRV KIT, POWER SUPPLY

• 411626, MS3 POWER SUPPLY BRACKET KIT

1. Install the 2 nuts by placing each nut into the adapter plate well. With one hand holding the
power supply, use the other hand to close up the power supply onto the adapter plate.

2. Flip the power supply over to ensure that the side with the screw holes is facing upward,

and then attach the power supply to the adapter plate by aligning the holes and then tighten
using the 2 Phillips screws.
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3. Holding the power supply unit snugly to the support bracket, tighten the 2 Phillips screws.

4. Thread the power cable from the power supply through one of the spaces next to the pole to
reach the device, and then connect the power cable to the device.

5. Connect the power cord to the mains outlet.

6. Power up the device.

Section D, remove the power supply from the mobile stand
This section applies to Spot 4400 devices with a 4400-MBS mobile stand meeting these criteria:

• 4400-MBS mobile stand manufactured after 02/2022* or later

• 4400-PS power supply manufactured before 02/2022* or earlier

• Power supply model: MENB1035A1500F02
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1. Power down the device.

2. Disconnect the power cable from the device and disconnect the power cord from the wall.

3. With one hand holding the power supply, remove the 2 Phillips screws that attach the power
supply to the bracket.

NOTE Set the screws, adapter plate, and well nuts aside for
reassembly.

4. Remove the power supply unit.

Recycle or dispose of the power supply unit in an environmentally safe manner consistent with
local regulations.

Section D, attach the power supply to the stand
This section applies to Spot 4400 devices with a 4400-MBS mobile stand meeting these criteria:

• 4400-MBS mobile stand manufactured after 02/2022* or later

• 4400-PS power supply manufactured before 02/2022* or earlier

• Power supply model: MENB1035A1500F02
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NOTE See the model number and label for further information.

Kit item:

• 4400-PS, SRV KIT, POWER SUPPLY

1. Install the adapter plate onto the wire bracket of the mobile stand.

2. Attach the power supply to the adapter plate by aligning the holes.

3. Holding the power supply unit snugly to the support bracket, tighten the 2 Phillips screws.
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4. Thread the power cable from the power supply through one of the spaces next to the pole to
reach the device, and then connect the power cable to the device.

5. Connect the power cord to the mains outlet.

6. Power up the device.
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Field replaceable units
 

This listing includes only field-replaceable service parts. Product accessories—including patient
sensors, probes, cables, batteries, probe covers, and other consumable items—are listed separately
in the accessories list in the Appendix of the Instructions for use.

This section begins with an illustration of the entire device followed by lists of service kits.

Repair parts/kits can be purchased through Hillrom sales channels. You can also visit the Hillrom
Parts Store online to purchase replacement parts and accessories for your Welch Allyn device.

NOTE Welch Allyn may limit availability of certain parts to Authorized Service
Personnel only. These limitations are required to maintain product safety, or
maintain current regulations. After the End of Manufacturing (EoM) date, repair
and service parts will be provided for 5 years or until parts are no longer available.
The Expected Service Life, per IEC60601-1 3rd Edition Sub-clause 4.4, is defined as a
period of 5 years.
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About service kits
The table describes the components of the device and the associated service kits for replaceable
parts.

Future revisions of a part might not always be backwards compatible with a legacy part.

List of service kits
To determine the correct replacement part for your unit, always provide the serial number and
model number when ordering.

Service Kit Number Material Number Description

1 107352 Srv Kit, Battery Door

2 BATT22 Srv Kit, Battery Pack, 2 Cell Lithium-ion Battery
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Service Kit Number Material Number Description

3 107214 Srv Kit, Back Housing with Labels*

4 107183 Srv Kit, LCD Bezel

5 107184 Srv Kit, Main PCA, and LCD Frame

6 105920 Srv Kit, NIBP Pump Assembly

7 105933 Srv Kit, NoninSpO2 PCBA

8 107185 Srv Kit, NoninSpO2 PCBA with Adapter Board

9 107186 Srv Kit, Power Harness

10 107187 Srv Kit, SureTemp Module with O-Ring

11 107189 Srv Kit, SureTemp Ribbon Cable

12 107354 Srv Kit, Probe Box Cap

13a 4400-PS Srv Kit, Power Supply

Spot Vital Signs 4400

13b (not shown) 4400-HPS Srv Kit, Power Supply 40W

Spot Vital Signs 4400 Extended Care

14 107212 Srv Kit, Battery Door Foam

15a 107213 Srv Kit, Front Housing with Power Switch

Spot Vital Signs 4400

15b 108202 Srv Kit, Front Housing with Power Switch

Spot Vital Signs 4400 Extended Care

16 107215 Srv Kit, Sensor Housing with Power Harness

17a 108241 Srv Kit, LCD with Touchscreen

Spot Vital Signs 4400 Extended Care

17b 105924 Srv Kit, LCD with Touchscreen

Spot Vital Signs 4400

18 107350 Srv Kit, SpO2 Insert Blank

19 107351 Srv Kit, SpO2Nonin Insert

*Not available for direct purchase.
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Cleaning the device
 

This section presents cleaning procedures that pertain to service and repair. For daily cleaning
requirements and approved cleaning agents, refer to the Instructions for use.

WARNING Patient injury risk. Clean all accessories, including cables and tubes,
before storing the accessories on the device or stand. This helps reduce the risk of
cross contamination and nosocomial infection.

WARNING Electric shock hazard. Before cleaning the device, disconnect the AC
power cord from the mains outlet and the power source.

WARNING Electric shock hazard. DO NOT immerse or autoclave the device or
accessories. The device and the accessories are not heat-resistant.

WARNING Liquids can damage electronics inside the device. Prevent liquids from
spilling on the device.

CAUTION Do not sterilize the device. Sterilization can harm the device.

Remove liquid spills from the device
Liquids can damage electronics inside the device. Follow these steps if liquids spill on the device.

1. Power down the device.

2. Disconnect the power cord from the mains outlet and the power source.

3. Remove battery pack from the device.

4. Dry excess liquid from the device.

5. Reinstall battery pack.

6. Reconnect the power cord.

7. Power on the device and verify that the device functions normally before using it.

If liquids possibly entered the device, remove the device from use until it has been properly dried,
inspected, and tested by qualified service personnel.

Dry the equipment
1. Allow all components except the LCD screen to air dry.

2. Wipe the LCD screen dry with a clean cloth.
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Store the device
Store the device according to facility guidelines to keep the device clean, dry, and ready for
service.
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Functional verification and calibration
overview
 

Functional verification tests

The functional verification tests help to confirm the proper operation of the device and its options.
The tests may also be useful as a diagnostic tool to help isolate a malfunction. It is not necessary to
disassemble the device to perform these tests.

For periodic service, you can—at a minimum—perform the basic functional verification tests
described in this manual. If you have the Gold edition of the service tool, you have the additional
capabillity to perform a complete functional verification and calibration of the device, but this is not
required for minimal periodic service.

In contrast, any time you open the device case, you must use the service tool, Gold edition, to
perform a complete functional verification and calibration of the device before returning the device
to service.

NOTE For instructions on using the Gold edition, see the service tool help files.

About the Welch Allyn Service Tool
The service tool is required to complete functional verification and calibration tests. The service tool
is available in the following editions:

• Standard unlicensed edition: Enables NIBP functional verification tests to satisfy the
recommended annual service. If any Standard unlicensed edition testing shows an out-of-
specification result, use the Gold edition to perform a full calibration.

• Gold edition: Checks the functionality and calibration of the device. As it checks the device,
the Gold edition also performs any needed calibration to bring the device within
specifications. This full suite of tests is required to complete a repair. Each time you open the
case, you must use the Gold edition to test the device before returning the device to normal
use.

NOTE Verify that the final test service record from the Welch Allyn Service Tool
shows evidence that each of the tests required for a given model number are
present and the test was performed.

For information about the service tool, see the following:

• For instructions on installing and using the service tool, see the Welch Allyn Service Tool
Installation and Configuration Guide.
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• To use the Standard unlicensed edition to test the NIBP module, follow the instructions in this
service manual.

• For instructions on using the Gold edition, see the service tool help files.

Standard unlicensed edition service tool tests performed
The service tool performs the following functions on the host device and installed options.

Test Description NIBP Temp SpO2 Host

Reads
firmware

Displays the firmware version

Firmware
upgrade

Loads the latest firmware into
the module

Leak test Verifies leaks using 100 cc
volume

Accuracy test
(NIBP)

Checks the accuracy of
transducers across the
pressure range

Overpressure
test

Verifies the maximum cuff
pressure

Gold edition service tool tests performed
The service tool tests the host device and installed options as listed in the following table.

Test Description NIBP Temp SpO2 Host

POST Performs the power-on self test (POST)¹

Firmware version Checks the firmware version

Firmware upgrade Loads the latest firmware into the module

Leak Verifies leaks using 100 cc volume

AD noise Checks noise on the pressure channel

Calibration Calibrates pressure transducers

Accuracy (NIBP) Checks the accuracy of transducers across the
pressure range

Dump Checks dump valves

Pump inflation Verifies the pneumatic pump

Overpressure Verifies pump limits
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Test Description NIBP Temp SpO2 Host

Probe detect Verifies the operation of the probe detect
switch²

Accuracy (Temp) Verifies the accuracy of the thermometer across
range

Temperature functional
check

Verifies temperature module with cal-key²

SpO2 functional check Verifies module operation with an SpO2
simulator

Display Verifies video output

Back light interface Verifies display LED back light

Touchscreen interface Verifies touchscreen calibration

LED Verifies the LED

Beeper Verifies the buzzer

Battery operation Verifies the internal battery

¹ POST testing checks the following:

• NIBP: ROM, RAM, A/D channels, calibration, and user configuration.

• Temperature: ROM, RAM, calibration, and heater.

• SpO2: ROM and RAM, and connection to the SpO2 board.

² SureTemp Plus only.

Electrical safety testing
Welch Allyn recommends performing ground continuity and leakage current tests after all open-
case repairs and dielectric strength testing is not recommended.

NOTE Perform dielectric strength testing only if there is a reason to doubt the
integrity of the electrical insulation (e.g. multiple trips of a residual-current device
or liquid ingress of a saline solution). If you determine this test should be
performed, return the device to Welch Allyn for service.

These recommendations trace to EN/IEC 60601-1 – Medical Electrical Equipment – Part 1: General
Requirements for Basic Safety and Essential Performance or EN/IEC 62353 – Medical Electrical
Equipment – Recurrent Test and Test After Repair of Medical Electrical Equipment.

Because of the variability of test equipment in the field, Welch Allyn does not include specific
instructions to perform electrical safety tests. When performing electrical safety tests, refer to your
test equipment manuals for detailed instructions to ensure proper test equipment setup that aligns
with the appropriate standard. The following table provides connections and test limits to assist
you in performing these tests.
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Test Limits

Ground continuity (see Note above) Ground continuity from EP stud (equipotential terminal)* to the Gnd pin
of the IEC power connector shall be no greater than 0.1 ohms.

Leakage current (see Note above) Leakage current shall be less than 500 µA from EP stud* to mains (Line
and Neutral pins of the IEC power connector).

Insulation resistance Dielectric strength shall be 500 V (DC) EP stud* to IEC mains (Line and
Neutral pins of the IEC power connector), and insulation resistance is
measured.

* To locate the equipotential terminal, see “Controls, indicators, and connectors."

Devices with an external power supply
The power bricks are CB Certified and UL Listed; they meet ALL of the requirements that the
Medical Device standard requires for power supplies. The manufacturer is required to perform
100% electrical safety testing on all of their power bricks prior to shipment. Welch Allyn does not
perform nor recommend testing on these external power bricks because additional testing would
put undue stress on the insulation system and possibly cause premature failures in the field. Open
case repairs of devices with external power supplies are only dealing with DC circuitry and robust
isolation circuits built into the printed circuit boards. No additional after-servicing testing is
required in that instance. The patient isolation systems within the device (Temperature Probe,
SpO2 sensor, etc.) all have visible isolation gaps built into the printed circuit board. The quality
control on the PCB and the thorough type-testing performed by the testing agency (ETL)
eliminates the need for further testing on the devices that are downstream from the mains
isolation device.

Devices with an internal power supply
The internal power supplies are CB Certified and UL Registered. These power supplies are an open
frame style (no protective enclosure). Therefore, the products that contain an internal power supply
require electrical safety testing. Open case repairs of devices with an internal power supply require
the recommended testing because those devices contain the open frame power supply, and the
testing involves the manipulation of wiring that carries 120 or 240 volts AC. Welch Allyn does not
recommend HiPot / Dielectric Withstand testing because of a potential stress on the insulation
system, which could cause premature failures.

Basic functional verification

Basic functional verification checks

NOTE Calibration is available only with the service tool, Gold edition.

These tests verify basic functionality of the NIBP, SpO2, and thermometry parameters. These tests
support the requirements of routine preventive maintenance. However, they are not a substitute
for the complete functional tests available with the service tool, Gold edition. Welch Allyn
recommends using the service tool, Gold edition, to perform preventive maintenance and
verification of the device when completing a repair.
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Basic functional verification tools
The list of tools below is what Welch Allyn uses to perform a basic device functionality check. Most
facilities use a device simulator or equivalent products to perform this test.

Material no. Description Qty Component

407672 BP test volume repair fixture 113670 1 NIBP

N/A SpO2 simulator 1 SpO2

06138-000 Cal-key, assembly, M690/692 1 SureTemp
Thermometry
Module

N/A Pressure meter (must include at least two
decimal points and be accurate to within
±0.5 mmHg)

1 NIBP

N/A PC running the Welch Allyn Service Tool on
Windows 10

1 All

web download Welch Allyn Service Tool

hillrom.com/en/services/welch-allyn-
service-tool/

1 NIBP, Software
updates

N/A Blood Pressure Y-tube 1 NIBP

620216 Fitting "Y" 1/8 X 1/8 X 1/8 1 NIBP

NIBP test setup
NOTE Connect the power supply to the Spot Vital Signs 4400 device. Failure to
connect the power supply to the Spot Vital Signs 4400 device will result in the
failure of the Welch Allyn Service Tool to recognize the NIBP module of the Spot
Vital Signs 4400 device.

For the NIBP leak test, overpressure test, or accuracy check, connect the test equipment shown
below. Connect the manifold to the volume repair fixture as indicated by the service tool or the test
procedure.
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7

5

6
4

2

3

No. Item No. Item

1 Spot Vital Signs 4400 device 5 PC

2 Test volume repair fixture with test manifold,
bulb, and valve

6 USB 2.0/5-pin type A to mini-B cable

3 Blood pressure Y-tube 7 AC power supply and connecter

4 Pressure meter (must include at least two
decimal points and be accurate to within
±0.5 mmHg)

Create a blood pressure Y-tube

The blood pressure Y-tube is a piece of custom test equipment that connects the device to the test
setup. The Y-tube is composed of a modified blood pressure hose and a Y-type fitting. Follow these
instructions to create a Y-tube.

1. Cut a 4500-30 blood pressure hose approximately 6 inches from the connector that connects
to the device.

2. Split the end of the dual-lumen hose to create two separate hoses. Make sure not to puncture
either hose.

3. Insert one end of the Y-type fitting into each end of the hose.

82 Functional verification and calibration overview Welch Allyn® Spot Vital Signs 4400



NIBP tests
For the NIBP leak test, overpressure test, or accuracy check, connect the test equipment according
to the test setup diagram for your configuration presented earlier in this section. Connect the
manifold to the volume repair fixture as indicated by the service tool or the test procedure.

NIBP leak test (Standard unlicensed edition)
The NIBP leak test is performed automatically using the service tool. The leak test pressurizes the
system with a start pressure (Ps) of 250 mmHg ± 10 mmHg. After 15 seconds (Tt) the end pressure
(Pe) is measured. The leak rate is calculated using the formula L = (Ps – Pe)/ Tt. The test fails if the
leak rate exceeds 5 mmHg in 15 seconds.

Perform an NIBP leak test

NOTE Connect the power supply to the Spot Vital Signs 4400 device. Failure to
connect the power supply to the Spot Vital Signs 4400 device will result in the
failure of the Welch Allyn Service Tool to recognize the NIBP module of the Spot
Vital Signs 4400 device.

1. Set up the test equipment including the Spot Vital Signs 4400 device power supply.

2. Connect AC power to a power source and then connect the power adapter to the device
before powering on the device.

3. Launch the service tool on the PC.

4. If the simplified interface is active, choose the Service option.

5. Power on the device.

6. Log on with your user ID and password or with ADMIN as the user ID and leave the password
field blank.

7. Select the device you want to test from the device list.

8. Click NIBP Sensor under the Device Information tab.

9. Click Leak Test in the NIBP Sensor pane on the right side of the window.

10. Follow the prompts until the test completes.

11. Click Close.

12. To view the results, open the active log file by selecting File > View Log File > Active log file
> Ok.

13. To record the results of your test, go to “Service record.”

NIBP overpressure test (Standard unlicensed edition)
The NIBP overpressure test is performed automatically using the service tool. The overpressure test
verifies that the NIBP system will prevent the pressure from exceeding 329 mmHg. To pass this test,
the device must shut down the pump and open the valves when the pressure is between 280
mmHg and 329 mmHg.

Perform an NIBP overpressure test

NOTE Connect the power supply to the Spot Vital Signs 4400 device. Failure to
connect the power supply to the Spot Vital Signs 4400 device will result in the
failure of the Welch Allyn Service Tool to recognize the NIBP module of the Spot
Vital Signs 4400 device.

NOTE If you are performing this test after performing the NIBP leak test, skip to
step 7.
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1. Set up the test equipment including the Spot Vital Signs 4400 device power supply.

2. Connect AC power to a power source and then connect the power adapter to the device
before powering on the device.

3. Launch the service tool on the PC.

4. If the simplified interface is active, choose the Service option.

5. Log on with your user ID and password or with ADMIN as the user ID and leave the password
field blank.

6. Power on the device.

7. Select the device you want to test from the device list.

8. Click NIBP Sensor under the Device Information tab.

9. In the NIBP Sensor pane on the right side of the window, click Over Pressure Test.

10. Follow the prompts until the test completes.

11. Click Close.

12. To view the results, open the active log file by selecting File > View Log File > Active log file
> Ok.

13. To record the results of your test, go to “Service record.”

NIBP accuracy check (Standard unlicensed edition)
The NIBP accuracy check is performed manually using the service tool to control the valves. The
accuracy check compares the reading from the primary transducer pressure shown in the service
tool window with the reading from an external calibrated digital pressure meter. The results of this
check are not recorded in the service tool log file. To record the results for your records, copy the
table in the service record section of the service manual. If a calibration is required, run the NIBP
calibration included with the Gold edition of the service tool.

WARNING Patient safety risk. If the primary transducer fails, the system might not
identify an overpressure condition at the right limit, causing injury when the
device is re-connected to a patient. To ensure patient safety, Welch Allyn
recommends that a qualified service technician perform a full functional
verification and calibration on an annual basis.

CAUTION Equipment calibration error can occur. This accuracy check verifies only
the accuracy of the primary transducer. If the safety transducer is out of calibration,
a calibration error can occur due to the pressure difference between the primary
transducer and the safety transducer. To avoid equipment calibration errors, Welch
Allyn recommends that a qualified service technician perform a full functional
verification and calibration on an annual basis.

Perform an NIBP accuracy check

NOTE Connect the power supply to the Spot Vital Signs 4400 device. Failure to
connect the power supply to the Spot Vital Signs 4400 device will result in the
failure of the Welch Allyn Service Tool to recognize the NIBP module of the Spot
Vital Signs 4400 device.

NOTE If you are performing this test after performing a previous NIBP check, skip
to step 7.

1. Set up the test equipment including the Spot Vital Signs 4400 device power supply.

2. Connect AC power to a power source and then connect the power adapter to the device
before powering on the device.
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3. Launch the service tool on the PC.

4. If the simplified interface is active, choose the Service option.

5. Log on with your user ID and password or with ADMIN as the user ID and leave the password
field blank.

6. Power on the device.

7. Select the device you want to test from the device list.

8. Click NIBP Sensor under the Device Information tab.

9. Click Accuracy Check in the NIBP Sensor pane on the right side of the window.

10. Connect the 500 CC volume.

11. Turn on the pressure meter and zero if necessary.

12. Check the accuracy at 0 mmHg.

13. Record the reading on the pressure meter and the service tool and compare the results.

14. Using the hand bulb, pressurize the NIBP system to 50 mmHg ± 5 mmHg and allow 10
seconds for the pressure to stabilize.

15. Record the reading on the pressure meter and the service tool and compare the results.

16. Using the hand bulb, pressurize the NIBP system to 150 mmHg ± 5 mmHg and allow 10
seconds for the pressure to stabilize.

17. Record the reading on the pressure meter and the service tool and compare the results.

18. Using the hand bulb, pressurize the NIBP system to 250 mmHg ± 5 mmHg and allow 10
seconds for the pressure to stabilize.

19. Compare the reading on the pressure meter to the service tool reading and record the results.

20. Click Open valve to open the NIBP valves. Verify that the pressure on the meter and service
tool change to zero.

21. Click Done to complete the check.

22. To record the results of your test, go to “Service record.”

Perform an NIBP accuracy test without the Welch Allyn Service Tool

The following tools are required to perform this test:

• Blood Pressure Bulb

• Pressure Meter

• Dual Lumen Pressure Tubing

• Pressure Test Box

1. In Advanced settings, navigate to Service > General.

2. Connect the dual lumen tubing to the device.

3. Connect one end of the tubing to the pressure meter and the other end to the test box.
Ensure each end is connected tightly and there are no leaks.

4. To initiate the verification process, touch Close Valve.

5. Use the blood pressure bulb to adjust the pressure to each threshold of 50/150/250 mmHg.

6. Compare the pressure displayed on the NIBP Pressure Verification screen and the pressure
meter.
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SpO2 tests
Select the procedure here that applies to your configuration to test the device's SpO2 function.
Connect the test equipment according to the test setup diagram for your configuration presented
here.

SpO2 test setup

For the SpO2 test, connect the test equipment shown below.

No. Item

1 Spot 4400

2 SpO2 simulator

3 Power supply

Perform an SpO2 accuracy test

Use this procedure to test only the device SpO2 function.

1. Power on the device.

2. Connect the SpO2 functional simulator to the SpO2 input connector.

NOTE In the following tests, if the simulator defaults are outside
the device alarm limits, adjust the limits or silence the alarms.

3. Set the simulator SpO2 saturation to 90% and pulse rate to 60 bpm.

4. Give the device up to 30 seconds to stabilize.

5. Verify the displayed saturation is 90% ±1 sat point, and the pulse rate is 60 ±1 bpm.

6. Disconnect the simulator.

Thermometry tests

Thermometry test setup

For the thermometry test, connect the test equipment shown below.
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No. Item No. Item

1 Spot 4400 3 Tester, calibration, 9600 Plus

2 Power supply 4 Cal-key, assembly, M690/692

SureTemp temperature system test

The SureTemp temperature system test is performed using a calibration key (cal-key). The
calibration key tests the system using a fixed resistance to display a temperature of 97.3 ± 0.2 °F
(36.3 ± 0.1 °C).

NOTE If your facility requires you to test the temperature probes, you will also
need to have heaters at three temperature settings to test the probes. See
"SureTemp temperature probe and system test."

Perform a SureTemp temperature system test

1. With the system power on and the temperature probe in the well, disconnect the probe cable
from the temperature input connector on the front of the device.

2. Connect the calibration key to the temperature input connector.

3. Remove the probe from the well.

4. Verify that the displayed temperature is 97.3 ± 0.2 °F (36.3 ±0.1 °C).

SureTemp temperature probe and system test

Use this procedure to test the temperature function while verifying the temperature probe. To
achieve accurate results, you must perform this test with the device in Direct mode.

Test each probe at the low, medium, and high set points on the tester. Repeat the procedure for
each thermometer and temperature to test.

Set up the 9600 Plus calibration tester

Place the tester on a level surface away from sunlight, drafts, and other sources of heat or cold.

The tester takes approximately 20 minutes to heat to the lowest set point.
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To expedite testing, Welch Allyn recommends the following practices:

• To eliminate waiting for the tester to heat to the next set point, use three testers, each set to
one of three different set points.

• When using only one tester to test several thermometers at all three temperatures, test all
thermometers at one set point before proceeding to the next set point.

• To eliminate waiting for the tester to cool down, start at the lowest set point. Because the
tester does not have an internal fan, it requires more time to cool down than to heat up.

Change the 9600 Plus set point

To scroll from one set point to the next, press and hold the Temperature Selection button until a
beep sounds.

The new set point appears in the upper left corner of the display. The device’s current temperature
appears, flashes, and continues flashing until the cavity reaches equilibrium at the new set point.
The 9600 Plus beeps when the set point is reached.

Perform a SureTemp temperature probe and system test

1. Set the 9600 Plus to the desired set point and wait for the display to stop flashing.

2. Insert the temperature probe, without a probe cover, into the thermistor device port on the
tester.

3. When  appears on the display, touch it to switch to Direct mode.

4. Wait for up to two minutes for the temperature reading to stabilize.

5. Record the results in the temperature service record.

6. Return the temperature probe to the probe well on the device.

7. Repeat the procedure as necessary until all thermometers are tested at each temperature.

To record the results of your test, go to "Service record."

Full functional verification and calibration

Functional verification test setup
Connect the test equipment to your device as shown in these drawings to complete the functional
tests described in this section.
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Item No. Material No. Description Qty

Required
Welch Allyn

purchase

Optional
Welch Allyn

purchase

(see Notes)

1 Varies Spot 4400 1 X

2 N/A PC running the Welch Allyn
Service Tool on Windows 10

1

3 N/A SpO2 simulator 1

4 3278-010 8000AA-2 WA REUSABLE
SENSOR ADULT, 2M

1 X

5 4400-PS Power supply 1 X

6 106275 Micro USB cable 1 X

7 N/A Pressure meter (must include
at least two decimal points
and be accurate to within ±0.5
mmHg)

1

8 407672 Test volume repair fixture
(113670) with test manifold,
bulb, and valve

1 X

9 N/A Blood pressure Y-tube 1 See instructions for creating
the Y-tube in the Basic

functional verification section.
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Item No. Material No. Description Qty

Required
Welch Allyn

purchase

Optional
Welch Allyn

purchase

(see Notes)

10 01802-110 Tester, calibration, 9600 Plus,
SureTemp

3 X

11 06138-000 Cal-key, assembly, M690/692 1 X

NOTE All items listed in this table are required to complete a full functional verification and
calibration. If Welch Allyn does not make an item available for purchase, you must provide it
yourself.

NOTE You may substitute items marked as an optional Welch Allyn purchase with
comparable OEM products.

Full functional verification check and calibration tools
The tools listed below are required to perform a full device functionality check and calibration. The
tools are used in conjunction with the Welch Allyn Service Tool, Gold license, to perform a device
calibration.

Material no. Description Qty Component

01802-110 Tester, calibration, 9600 Plus 3 SureTemp Plus probes

407672 BP test volume repair fixture 113670 1 NIBP

N/A SpO2 simulator 1 SpO2

06138-000 Cal-key, assembly, M690/692 1 SureTemp Plus Thermometry
Module

N/A Pressure meter (must include at least two
decimal points and be accurate to within ±0.5
mmHg)

1 NIBP

106275 Micro USB cable 1 All

N/A PC running Windows 10 1 All

107334 Welch Allyn Service Tool Gold license for Spot
4400

1 NIBP, Software updates

web
download

Welch Allyn Service Tool

hillrom.com/en/services/welch-allyn-service-
tool/

1 NIBP, Software updates and
calibration

4500-30 Blood pressure hose, 5 ft. 1 NIBP

620216 Fitting "Y" 1/8 X 1/8 X 1/8 1 NIBP
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Material no. Description Qty Component

N/A USB Flash Drive 1 Host Controller, Log File
Capture

Initialize the NIBP board
Functional verification and calibration must be performed each time the device is disassembled or
more frequently if your facilty's procedures require a full calibration on a specified basis. If you have
just replaced a Main PCA board, your first step before performing a full verification and calibration is
to initialize the NIBP Board.

1. Set up the equipment for full functional verification as shown earlier in this section.

2. Log in to the Welch Allyn Service Tool, highlight your device in the Device list, and click Select.

This action opens the Spot 4400 > Device information subtab. Depending on your
configuration, it could take 30-45 seconds to populate this subtab.

3. Select the Verify and calibrate subtab.

4. Select NIBP sensor in the Device field.

5. Click Calibrate.

This opens the Verify and calibrate NIBP Sensor dialog.

6. Click Begin.

A list of tests appears in the left pane of the dialog along with three controls in the right pane.

7. Click Initialize NIBP Board in the right pane.

A confirmation window appears with the message, "Are you sure you want to reset the
calibration offsets of the NIBP Board?"

8. Click Yes.

This action places two tests in the queue for initialization: the Power Calibration Test – Primary/
Safety and the Pressure Calibration – Primary/Safety.

NOTE A message appears in the right pane to indicate the first test
is in progress. If the test passes, a green check appears to the left of
the test name, and the second test begins. If the test fails, a red
check appears to the left of the test name, followed by a prompt to
rerun the test. You cannot proceed to the second test until the first
test passes.

9. Rerun the Power Calibration Test as needed until the test passes.

10. If you did not set up your equipment for a full calibration intially, connect the 500cc volume to
the device when prompted and then click Next.

NOTE You cannot initialize the board without setting up the
equipment for the Pressure Callibration test.

11. Observe the pressure calibration messages onscreen and follow the onscreen prompts to
manually adjust device pressure with the hand bulb to 250 ± 5 mmHg.

12. Once you reach the targeted pressure, enter the exact value on the pressure meter in the
Meter pressure field, then click Next to record this value.

If the test passes, a green check appears to the left of the test name. If the test fails, a red check
appears to the left of the test name, followed by a prompt to rerun the test.
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13. Rerun the Pressure Calibration test as needed until the test passes.

14. If the second test passes, click Close.

The NIBP board is now initialized.

Configure the main PCA board
After installing a new PCA board, use the Welch Allyn Service Tool, Gold Edition, to prepare the
board for first-time use. This includes programming the device serial number into the new board
and initializing the NIBP board.

1. Log in to the Welch Allyn Service Tool, highlight your device in the Device list and click Select.

2. Select Spot 4400 > Configure, and then click Change.

The Change device configuration settings dialog box appears.

3. Enter the device serial number.

The device serial number is located on the bottom of the device.

4. If the serial number of the main circuit board does not appear, enter it as the host controller
serial number.

The serial number is located on the circuit board.

5. Select the appropriate device model number from the drop-down list.

6. Click Save.

If you have not done so already, complete functional verification and calibration before using the
device.
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Options and upgrades
 

Welch Allyn may support option and software upgrades for Spot Vital Signs 4400 (Spot 4400 ).

Option upgrades for devices still under warranty that require any installation inside the device must
be performed by a Welch Allyn service center unless you participate in the Partners in Care Biomed
Partnership Program. If you want to install the options, we recommend you attend either the
classroom or online technical training course for the device. The training is required to be eligible
to receive the Welch Allyn Service Tool Gold edition. The Gold edition is required to verify that the
device is functioning correctly after it has been serviced. Although all of the option upgrades are
calibrated and tested before leaving the factory, Welch Allyn recommends performing a complete
functional test whenever the device is serviced.

NOTE For the Welch Allyn Service Tool to support updates and upgrades, adjust
your firewall settings to permit access for IP address 169.254.10.10 (the local feed
server for the software upgrade process).

Software upgrades, when available, can be purchased or provided at no charge if your device is
covered by a Welch Allyn Service Agreement. The upgrades can be installed by either a Welch Allyn
service center or by using the service tool, Standard unlicensed or Gold edition.

If you choose to install software upgrades on your own, you will receive the software through the
internet. When ordering software, provide the serial number of the device you want to install the
software on.

NOTE The device must be plugged in to AC power and have at least 15 minutes
of battery charge remaining to execute software upgrades. You can download
software upgrades on battery power, but you cannot implement them without AC
power.

Available options
CAUTION Before installing any option, disconnect the patient from the device
and power down the device.

Options

Model 44WT 44XT

Spot 4400 with NIBP, SureTemp, NoninSpO2

Spot 4400 with NIBP, SureTemp
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 Standard with this model. Not available

Upgrading software with the Welch Allyn Service Tool
The Spot 4400 and the Welch Allyn Service Tool (WAST) interact through Ethernet over USB
technology, enabling the device to function as a USB device with both a network and an IP address.
This connection separates logically into two distinct interfaces: a generic USB serial connection and
a Remote Network Driver Interface Specification (RNDIS) network interface, which is a Microsoft
Windows driver. Most interactions between the WAST and the Spot 4400 take place over the
generic USB serial connection. In contrast, software upgrades require the RNDIS interface for the
device to connect the WAST and download the firmware.

During software upgrade, the Ethernet over USB interface with the WAST is auto-configured with
the specifications noted in the table below. When the Spot 4400 reaches out to the WAST for the
firmware package, it uses either one of the following TCP ports: 80/443. Be prepared to modify any
firewall(s) that prevent incoming connections to allow this traffic. The WAST attempts to configure
the Windows firewall by opening this specific port on the RNDIS interface. If administrative controls
such as a Group Policy Object (GPO) or third-party software have been implemented to prevent
this change, the WAST attempts to diagnose the problem and then inform you of possible
remediation steps. Work with your IT staff or Network Administrator as needed to enable this
functionality.

Interface specifications IP address Network mask

Device Ethernet over USB interface 169.254.10.10 255.255.255.255

WAST RNDIS interface 169.254.10.1 255.255.255.255

At the start of a software upgrade, the Welch Allyn Service Tool creates a local HTTP server and uses
the USB connection to transfer necessary file package to the Spot 4400. Once the file package is on
the device, it launches the installation of host controller firmware and reboots the device
immediately following the installation. When the device auto-reboots, the software upgrade of
individual modules and sensors (NIBP, SpO2, and/or Temperature) is complete.

Software rollback capability
The Spot 4400 utilizes a primary and secondary software structure. In the final step of the software
upgrade, the device rolls the previous firmware package to a secondary image and identifies the
newly installed firmware as its primary image. This structure allows rollback to previous versions as
needed. For example, if you performed a software upgrade and then determined that it didn't
meet your expectations or conform to your workflow, you can execute a software rollback in
seconds and limit device downtime. To roll back your software, follow these steps:
1. Connect the device to your laptop and open the Welch Allyn Service Tool.
2. Click the Configure tab.
3. In the Current settings window, click Change....
4. Click the Device Software Rollback tab.
5. Click Rollback.
6. In the Confirm Device Software Rollback dialog, click Yes to confirm.
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In addition, because the software upgrade is already loaded on your device, you can use the
rollback capability at a later time to implement the upgrade and complete the associated setup
activities. Follow the same steps presented above to activate the new firmware.

Upgrade the device firmware
Updating a device requires a PC, a USB cable and an Internet connection.

1. To launch the Welch Allyn Service Tool, from the Start menu select All Programs > Welch
Allyn > Welch Allyn Service Tool.

2. Click Service.

3. Click Login.

a. Enter the user name: ADMIN.

b. Leave the password blank.

4. Connect the device to the computer with a USB cable.

5. Turn on the device.

6. In the Welch Allyn Service Tool, under the Device List tab, click on the device and click Select.

7. Under the Welch Allyn Connex Device, select Upgrade.

The list of available upgrades appears.

8. Select the desired upgrade, click Upgrade and then click Yes.

When the upgrade is complete, the Upgrade tab will display No Upgrade Available.

9. Close the Device tab, and then close the Service Tool.

10. Disconnect the USB cable from the device, and then turn off the device.

SmartCare services for maintenance and repair

SmartCare protection plans

Material no. Item

S1-4400-PRO-1 4400 SmartCare Protection 1YR

S1-4400-PRO-3 4400 SmartCare Protection 3YR

S1-4400-PRO-PS 4400 SmartCare Protection 3YR POS

SmartCare protection plus plans
SmartCare protection plus plans include onsite repair.

Material no. Item

S9-4400-PROPLUS-1 4400 SmartCare Protection Plus 1YR
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Material no. Item

S9-4400-PROPLUS-3 4400 SmartCare Protection Plus 3YR

S9-4400-PROPLUS-PS 4400 SmartCare Protection Plus 3YR POS

SmartCare biomed plans

Material no. Item

S1-4400 4400, Comprehensive partnership program point of sale

S1-4400-2 4400, Comprehensive partnership program 1 year renewal

Service and repair training
NOTE Required to be eligible to receive the Welch Allyn Service Tool, Gold
edition.

Material no. Item

4400REP-TRN 4400, Repair training

4400REP-WEB-TRN 4400, Repair web training

4400REPRC-WEB-TRN 4400, Repair re-certification web training
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Appendix
 

Specifications

Physical specifications

Protection classifications, all device configurations

Characteristic Specification

Electrical rating Power supply model: FW8031M/DT/15
Input: 100 – 240 V AC, 50 – 60 Hz, 0.6 A – 0.3 A
Output: 15 V DC, 2.0 A

Power supply model: MENB1035A1500F02
Input: 100 – 240 V AC, 50 – 60 Hz, 0.8 A – 0.5 A
Output: 15 V DC, 2.33 A

Duty cycle Continuous operation

Type of protection against electric shock Class I internally powered

Degree of protection against electric shock, for parts
applied to patients

Type BF defibrillator proof

IEC EN 60601-1, 2nd and 3rd Editions

Recovery time following defibrillator discharge
Less than or equal to 15 seconds

Flammable anesthetics
WARNING Not suitable for use
with flammable anesthetics.

Degree of protection provided by the enclosure with
respect to harmful ingress of liquids

IPX2 Protected against vertically falling water drops
when enclosure tilted up to 15°

Height 10.1 in. (25.7 cm )

Width 9.3 in. (23.6 cm )

Depth 4.9 in. (12.4 cm )
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Protection classifications, all device configurations

Weight (including battery) 3.8 lb (1.7 kg )

Graphical display resolution

Dimensional outline 6.5 in. (W) x 4.1 in. (H) x 0.13 in. (D) (164.9 mm [H] x
103.8 mm [W] x 3.40 mm [D] )

Active area 6.1 in. (W) x 3.4 in. (H) (154.08 mm [W] x 85.92 mm [H])

Resolution 800 x 480 pixels

Pixel arrangement RGB (red, green, blue)

Pixel size 63.2 µm (W) x 179 µm (H)

Luminance 530 cd/m2

Battery specifications

2 Cell battery specifications Hours of use

Ambulatory care continuous 12 minute cycles - 40 patient cycles 8

NIBP specifications

NIBP specifications

Cuff pressure range Meets or exceeds IEC/ISO 80601-2-30 standards for
cuff pressure range

Systolic range Adult: 30 to 260 mmHg (StepBP, SureBP)
Pediatric: 30 to 260 mmHg (StepBP, SureBP)

Diastolic range Adult: 20 to 220 mmHg (StepBP, SureBP)
Pediatric: 20 to 220 mmHg (StepBP, SureBP)

Cuff Inflation Target Adult:160 mmHg (StepBP)
Pediatric: 140 mmHg (StepBP)

Maximum Target Pressure Adult: 280 mmHg (StepBP, SureBP)
Pediatric: 280 mmHg (StepBP, SureBP)

Blood pressure determination time Typical: 15 seconds
Maximum: 150 seconds
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NIBP specifications

Blood pressure accuracy Meets or exceeds ANSI.AAMI SP10:2002 standards for
noninvasive blood pressure accuracy (±5 mmHg
mean error, 8 mmHg standard deviation)

Mean Arterial Pressure (MAP) range

The formula used to calculate MAP yields an
approximate value.

Adult: 23 to 230 mmHg (StepBP, SureBP)
Pediatric: 23 to 230 mmHg (StepBP, SureBP)

Pulse rate range (using blood pressure determination) Adult: 30 to 200 bpm (StepBP, SureBP)
Pediatric: 30 to 200 bpm (StepBP, SureBP)

Pulse rate accuracy (using blood pressure
determination)

±5.0% (±3 bpm)

Overpressure cutoff Adult: 300 mmHg ±15 mmHg
Pediatric: 300 mmHg ±15 mmHg

SureTemp Plus temperature module specifications

SureTemp Plus temperature module specifications

Temperature range (all
measurement sites)

80 °F to 110 °F (26.7 °C to 43.3 °C)

Calibration accuracy ±0.2 °F (±0.1 °C) (Direct mode)

Laboratory accuracy

Temperature measurement range Ambient

64.4 °F (18 °C) to 82.4 °F
(28 °C)

Ambient

50 °F (10 °C) to 64.4 °F (18
°C) or 82.4 °F (28 °C) to 113
°F (40 °C)

Less than 95.9 °F (35.5 °C) ±0.36 °F (±0.2 °C) ±0.36 °F (±0.2 °C)

95.9 °F (35.5 °C) to less than 96.4 °F (35.8 °C) ±0.18 °F (±0.1 °C) ±0.36 °F (±0.2 °C)

96.4 °F (35.8 °C) to less than 98.0 °F (37.0 °C) ±0.18 °F (±0.1 °C) ±0.3 °F (±0.2 °C)

98.0 °F (37.0 °C) to 102.0 °F (39.0 °C) ±0.18 °F (±0.1 °C) ±0.2 °F (±0.1 °C)

Greater than 102.0 °F (39.0 °C) to 106.0 °F (41.0 °C) ±0.18 °F (±0.1 °C) ±0.3 °F (±0.2 °C)

Greater than 106.0 °F (41.0 °C) to 107.6 °F (42.0 °C) ±0.18 °F (±0.1 °C) ±0.36 °F (±0.2 °C)

Greater than 107.6 °F (42.0 °C) ±0.36 °F (±0.2 °C) ±0.36 °F (±0.2 °C)
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Thermometry clinical accuracy validation

For a copy of our Clinical Validation Study, please contact Hillrom Customer Care.

SpO2 specifications
Refer to sensor manufacturer's directions for use for additional information.

WARNING Functional testers cannot be used to assess the accuracy of a pulse
oximeter device.

While functional testers may be useful for verifying that the pulse oximeter sensor, cabling, and
device are functional, they are incapable of providing the data required to properly evaluate the
accuracy of a system's SpO2 measurements. Fully evaluating the accuracy of the SpO2
measurements requires, at a minimum, accommodating the wavelength characteristics of the
sensor and reproducing the complex optical interaction of the sensor and the patient’s tissue.
These capabilities are beyond the scope of known bench-top testers. SpO2 measurement accuracy
can only be evaluated in vivo by comparing pulse oximeter readings with SaO2 measurements
obtained from simultaneously sampled arterial blood made using a laboratory CO-oximeter.

NOTE Contact the sensor manufacturer for further SpO2 clinical testing
information.

NOTE Refer to sensor manufacturers' directions for use for further accuracy
information.

SpO2 specifications

SpO2 performance measurement range 1 to 100%

Nonin sensor accuracy guide SpO2 accuracy testing is conducted during
induced hypoxia studies on healthy, non-
smoking, light-to-dark-skinned subjects during
motion and no-motion conditions in an
independent research laboratory. The
measured arterial hemoglobin saturation value
(SpO2) of the sensors is compared to arterial
hemoglobin oxygen (SaO2) value, determined
from blood samples with a laboratory co-
oximeter. The accuracy of the sensors in
comparison to the co-oximeter samples
measured over the SpO2 range of 70 – 100%.
Accuracy data is calculated using the root-
mean-squared (Arms value) for all subjects, per
ISO 9919:2005, Standard Specification for Pulse
Oximeters for Accuracy.

Pulse rate
18 to 300 bpm: ± 3 digits

Low perfusion (40 to 240 bpm): ± 3 digits

Saturation

NOTE Saturation accuracy varies by sensor
type.

70% to 100%

Adult/Pediatrics

No Motion

Finger Clip: ± 2 digits

Flex: ± 3 digits
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SpO2 specifications

Motion

Finger Clip: ± 2 digits

Flex: ± 3 digits

Low Perfusion

All Sensors: ± 2 digits

Environmental specifications

Operating temperature 50 °F to 104 °F (10 °C to 40 °C)

Storage/Transport temperature -4 °F to 122 °F (-20 °C to 50 °C)

Storage/Transport/Operating altitude and
atmospheric pressure

-1250 to 10,000 ft. (-381 m to 3,048 m)
70 kPA to 106 kPA

Operating humidity 15% to 90% noncondensing

Storage/Transport humidity 15% to 95% noncondensing

USB flash drive requirements
The multiple vendor technologies used in the manufacture of USB flash drives make some of them
incompatible with this device. Common issues that cause flash drives not to function are NTFS
formatting, proprietary drive security, and the need for Windows drivers to run or access them.

The requirements for a USB flash drive to work with this device are the following:

• Linux compatibility

• Up to 32 GB storage

• FAT 32 formatting

• USB 2.0 compliant

Dimensions: Assuming the USB flash drive will be inserted into the device, the length of the stick
does not matter. The size of the stick surrounding the USB metal head should be no larger than 9.5
mm x 18.5 mm to fit in the USB port.

Welch Allyn recommends the following USB flash drive for use with the device: Kingston
DataTraveler SE9 32 GB drive, part number DTSE9H/32GBZ.

Factory defaults
NOTE Factory defaults are the settings in the device when it comes off the
manufacturing floor. Customized configuration files modify these defaults based
on preferences for specific sites. Restoring default settings on a device returns it to
its manufacturing floor defaults, not the custom configuration.
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Device

Settings Default value

Date format MM/DD/YYYY

Time zone Europe/London

Daylight Saving Time enabled Yes

Patient mode Adult

Allow auto sleep mode Yes

Sleep mode interval 2 min

Allow auto shutdown Yes

Auto shutdown timeout interval 15 min

Brightness 5

Language English

Manual parameters

Settings Default value

Display height Yes

Display weight Yes

Display pain Yes

Display respiration Yes

Display BMI Yes

Height units inches

Weight units lbs

NIBP

Settings Default value

NIBP views SYS/DIA

NIBP units mmHg
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Settings Default value

NIBP algorithm SureBP

NIBP adult inflation preset (CIT) or Default inflation pressure 160 mmHg (21.3 kPa)

NIBP pediatric inflation preset (CIT) or Default inflation pressure 140 mmHg (18.7 kPa)

Adult max cycle pressure Auto (300 mmHg, 40.0 kPa )

Pediatric max cycle pressure Auto (300 mmHg, 40.0 kPa)

NIBP Averaging

Include readings 1 - No
2 - Yes
3 - Yes
4 - No
5 - No
6 - No

Delay to start 1 min

Time between 1 min

Keep if +/- 20mmHg

Temperature

Settings Default value

Temperature units Fahrenheit

Allow temperature conversion display Yes

Default site for oral probe Oral

Troubleshooting
This section provides the following tables to help troubleshoot the device.

• Interpreting log file output: The tables and sample calculations in this topic show you how
to parse and interpret error log messages.

• Symptoms and solutions: This simple table lists symptoms you might observe, possible
causes, and suggested actions that might eliminate the problem.

• Information and error messages: These tables list messages generated by the device
software when a problem is detected. The tables explain possible causes and suggest actions
that can resolve the problem. Compare to the Symptoms and solutions table, these tables are
much more exhaustive.
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These tables can help you diagnose and fix a problem. They do not replace basic troubleshooting
skills. You must still trace the source of the problem to the board or module level to decide the best
course of action. Welch Allyn does not support component-level repair to the board or module. For
available replacement parts, see “Field Replaceable Units.”

WARNING Do not perform troubleshooting on a device that is emitting smoke or
exhibits other signs of excessive overheating. Disconnect the device from AC
power and call Welch Allyn Technical Support immediately.

CAUTION Replace parts, components, or accessories only with parts supplied or
approved by Welch Allyn. The use of any other parts can lead to inferior device
performance and will void the product warranty.

Interpreting log file output
The device supports saving log files to a USB flash drive. You can then read saved log files on a PC
to assist in analysis. This method allows access to the log files without having to connect the device
to a PC. 

Save log files
Complete the following steps to save a log file to a USB flash drive:

1. Insert a compatible USB flash drive into the USB port of the device.
2. Access Advanced settings.
3. Navigate to Service > Log file. 
4. Touch Save to USB. A "Save successful" message appears after a successful save.
5. Remove the USB flash drive from the USB port.

Access log files
Complete the following steps to access and start working with log files saved to a USB flash drive:

1. Insert the USB flash drive into a USB port on your PC.
2. Open the USB flash drive and identify the saved log files. Look for .zip files that resemble this

example, with the first set of numbers being a datestamp in the YYYYMMDD format:

logfiles_20150108_193903_179.zip

3. Open the .zip file, and then open the desired messages .zip file. Multiple messages files might
be saved on the USB drive, so check the datestamp in the filename to select the desired .zip
file. For example,

messages_2015_01_08.zip

The available log files appear onscreen. The largest file is the latest file of the day. The filenames
resemble this example:

messages_2015_01_08_0000000008

4. Right-click on the desired log file, select Open, and then select Notepad ++ as the program to
open the file.

The log file opens and is ready for analysis.

Log message format
Knowing how to interpret log file output can help you to troubleshoot issues on the device. All log
messages follow this format:

<PRI>ISODATE(sp)MSGHDR:(sp)MSG(new-line)
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The following table defines each element of the log message.

<PRI> The facility number and the severity number concatenated into an 8-bit value.

NOTE The PRI values and calculations performed with them are useful
primarily to Welch Allyn engineers. Most biomeds and service
personnel can focus on the other details of log messages to complete
their analysis.

ISODATE The date and time at which the message was generated in the ISO 8601 compatible
standard timestamp format (yyyy-mm-ddThh:mm:ss.mmm+-ZONE). This is picked up
from the device system time.

MSGHDR Message header: The name and the PID of the program or process that sent the log
message in PROGRAM[PID]: format. It includes a trailing whitespace.

MSG The text of the log message from the sending program or process. This is a free-format
text string, terminating with a new-line character.

(sp) A single-space character.

(new-line) A new-line character.

Sample log messages:

<13>2014-09-26T12:18:45.000+00:00 wa_nibpd[1326]: NibpManualBpCancelState-
>Enter

<150>2014-09-08T05:55:00.000+00:00 wa_spo2nonind[1521]: Code 1, SPO2 sensor not 
connected

As noted above, the calculations performed using PRI values have little significance for most users
but are valuable for Welch Allyn engineers. Therefore, the following instructions for calculating
facilty and severity numbers target Welch Allyn engineers.

To obtain the facility number, divide the PRI value by 8 (dropping the fraction from the result). The
facility number is one of the following:

Facility Number Description

0 Kernel messages

1 User-level messages

2 Mail system

3 System daemons

4 Security/authorization messages (auth)

5 Messages generated interally by syslogd

6 Line printer subsystem

7 Network news subsystem

8 UUCP subsystem
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Facility Number Description

9 Clock daemon

10 Security/authorization messages (authpriv)

11 FTP daemon

12 NTP subsystem

13 Log audit

14 Log alert

15 Clock daemon (cron)

16 BioMed messages (aka local-0)

17 Manufacturing messages (aka local-1)

18 Service messages (aka local-2)

19 Engineering messages (aka local-3)

20 Not Used (aka local-4)

21 Not Used (aka local-5)

22 Not Used (aka local-6)

23 Not Used (aka local-7)

To obtain the severity number, subtract the (facility times 8) value from the PRI value. The severity
number is one of the following:

Severity
Number

Severity Name Description

0 EMERG A panic condition

1 ALERT A condition that should be corrected immediately

2 CRITICAL Critical conditions, such as hard device errors

3 ERROR Error messages

4 WARNING Warning messages

5 NOTICE Conditions that are not errors but may require
attention

6 INFO Information messages

7 DEBUG Debug messages
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Sample calculation/interpretation
For each of the sample error logs presented, we can determine the following:

<13>2014-09-26T12:18:45.000+00:00 wa_nibpd[1326]: NibpManualBpCancelState-
>Enter

<PRI> = 13

ISODATE = 2014-09-26T12:18:45.000+00:00

MSGHDR = wa_nibpd[1326]:

MSG = NibpManualBpCancelState

Facility = <PRI> ÷ 8 = 13 ÷ 8 = 1.625 = 1 when rounded down = User-level messages

Severity = <PRI> – (Facility x 8) = 13 – (1 x 8) = 13 – 8 = 5 = NOTICE

<150>2014-09-08T05:55:00.000+00:00 wa_spo2nonind[1521]: Code 1, SPO2 sensor not 
connected

<PRI> = 150

ISODATE = 2014-09-08T05:55:00.000+00:00

MSGHDR = wa_spo2nonind[1521]:

MSG = Code 1, SPO2 sensor not connected

Facility = <PRI> ÷ 8 = 150 ÷ 8 = 18.75 = 18 when rounded down = Service messages (aka local-2)

Severity = <PRI> – (Facility x 8) = 150 – (18 x 8) = 150 – 144 = 6 = INFO

Symptoms and solutions

Symptom Possible cause Suggested action

General

All tests for the device were not
run with the Welch Allyn
Service Tool.

The device is not connected to a power
supply.

Plug the device into the
electrical outlet and then
connect the power supply to
the device.

Initialization of the device and the Welch
Allyn Service Tool is required.

Re-boot the device and the
PC. Relaunch the Welch Allyn
Service Tool and retest the
device.

The device does not power up. A new battery was installed. Connect AC power to wake
up the battery.

The battery is discharged. Connect AC power to charge
the battery.

The power switch is defective. Replace the power switch.

Service manual Appendix 107



Symptom Possible cause Suggested action

The power supply is defective. Check the output voltage on
the power supply. The voltage
should be 15 V ± 0.45V DC. If it
is not, replace the power
supply.

The battery is dead or defective. Charge the battery for 5 hours.
If the battery icon on the
display still shows an empty
battery symbol, replace the
battery.

The main board is defective. Replace the main board.

The touchscreen is
unresponsive.

Touchscreen needs calibration. Calibrate the touchscreen.

Run the Host Calibration
Sequence from the Service
Tool.

Replace the LCD /
touchscreen.

Replace the main board.

The device is powered on but
the display is blank.

The device is in Sleep mode. Touch the screen.

A hardware component has failed. Run the Host Calibration
Sequence from the Service
Tool.

Replace the LCD /
touchscreen.

Replace the main board.

NIBP

Blood pressure readings are
inaccurate.

Incorrect cuff size, improperly placed cuff, or
incompatible cuff.

Determine correct cuff size by
measuring patient's arm
circumference midway
between the elbow and the
shoulder. Then use a properly
sized cuff.

Use reference markings on the
cuff to place it properly.

Use only Welch Allyn cuffs.

Patient's arm is not positioned properly or
moves during blood pressure cycle.

Ensure patient's arm is resting
on a surface at heart level.

Keep arm still to reduce
artifact.
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Symptom Possible cause Suggested action

Blood pressure cuff is placed over clothing. Take blood pressure on a bare
arm.

The patient is experiencing arrhythmia. Check for regularity of heart
rate (palpate pulse or check
device).

There is a leak in the pneumatic system. Ensure all cuff attachments are
tight. Carefully check for leaks
in blood pressure cuff and
tubing attached to the device.

Replace the cuff.

Update the software.

Perform NIBP functional
checks.

Perform NIBP calibration
checks.

Replace the pump assembly.

Replace the main board.

The NIBP module needs calibration. Update the software.

Perform NIBP functional
checks.

Perform NIBP calibration
checks.

Replace the pump assembly.

Replace the main board.

The NIBP module malfunctioned. Update the software.

Perform NIBP functional
checks.

Perform NIBP calibration
checks.

Replace the pump assembly.

Replace the main board.

The dual lumen switch failed. Ensure that the cuff is the
properly sized.

Clean the cuff connections.

Replace the cuff and tubing.
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Symptom Possible cause Suggested action

Replace the main board.

The NIBP cuff does not inflate.
NIBP is not functioning.

There is a leak in the pneumatic system. Ensure all cuff attachments are
tight. Carefully check for leaks
in blood pressure cuff and
tubing attached to the device.

Replace the cuff.

Update the software.

Perform NIBP functional
checks.

Perform NIBP calibration
checks.

Replace the pump assembly.

Replace the main board.

The NIBP module malfunctioned. Update the software.

Perform NIBP functional
checks.

Perform NIBP calibration
checks.

Replace the pump assembly.

Replace the main board.

The main board malfunctioned. Update the software.

Perform NIBP functional
checks.

Perform NIBP calibration
checks.

Replace the pump assembly.

Replace the main board.

The dual lumen switch failed. Ensure that the cuff is the
properly sized.

Clean the cuff connections.

Replace the cuff and tubing.

Replace the main board.

The NIBP module needs calibration. Update the software.
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Symptom Possible cause Suggested action

Perform NIBP functional
checks.

Perform NIBP calibration
checks.

Replace the pump assembly.

Replace the main board.

Attempt to upgrade the
software failed.

The hardware or software between the Host
and the device is incompatible.

Retry software update.

Replace the main board.

The device lost communication with the
network or a timing issue occurred during
the upgrade.

Retry software update.

Replace the main board.

Temperature

Temperature measurements are
inaccurate.

Probe is placed improperly. Ensure that the probe is
properly placed in the
measurement site. For oral
temps, place the probe in the
most posterior sublingual
pocket.

The probe malfunctioned. Replace the probe.

Perform temperature
functional checks.

The probe cover is faulty or incorrectly
attached.

Verify the condition of the
probe cover and that it covers
the probe completely.

Replace the probe cover.

The probe or the window is dirty or
contaminated.

Clean the probe or window.

Replace the probe.

The temperature module malfunctioned. Update the software.

Replace the temperature
module.

Replace the main board.

The main board malfunctioned. Update the software.

Replace the main board.

Temperature measurements are
not displayed.

The probe is disconnected from the device. Ensure that the temperature
probe is connected and
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Symptom Possible cause Suggested action

seated in the probe well
before taking a measurement.

Probe is placed improperly. Ensure that the probe is
properly placed in the
measurement site. For oral
temps, place the probe in the
most posterior sublingual
pocket.

The probe malfunctioned. Replace the probe.

Perform temperature
functional checks.

The temperature module malfunctioned. Update the software.

Replace the temperature
module.

Replace the main board.

A software issue occurred. Update the software.

Replace the temperature
module.

Replace the main board.

The probe or the window is dirty or
contaminated.

Clean the probe or window.

Replace the probe.

The main board malfunctioned. Update the software.

Replace the main board.

SpO2

SpO2 measurements are not
displayed.

The sensor is faulty or incorrectly attached. Connect the sensor to the
patient and the device.

Replace the sensor.

Perform SpO2 functional
checks.

The sensor is contaminated or dirty. Clean the optical area of the
sensor.

Replace the sensor.

Perform SpO2 functional
checks.
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Symptom Possible cause Suggested action

The SpO2 module malfunctioned. Perform SpO2 functional
checks.

Update the software.

Replace the SpO2 module.

Replace the main board.

The main board malfunctioned. Update the software.

Replace the main board.

SpO2 measurements are
inaccurate.

The sensor is faulty or incorrectly attached. Connect the sensor to the
patient and the device.

Replace the sensor.

Perform SpO2 functional
checks.

The sensor is contaminated or dirty. Clean the optical area of the
sensor.

Replace the sensor.

Perform SpO2 functional
checks.

The SpO2 module malfunctioned. Perform SpO2 functional
checks.

Update the software.

Replace the SpO2 module.

Replace the main board.

The main board malfunctioned. Update the software.

Replace the main board.

Attempt to upgrade the
software failed.

The hardware or software between the Host
and the SpO2 module is incompatible.

Retry software update.

Replace the SpO2 module.

Replace the main board.

The device lost communication with the
network or a timing issue occurred during
the upgrade.

Retry software update.

Replace the SpO2 module.

Replace the main board.

The temperature module malfunctioned. Update the software.
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Symptom Possible cause Suggested action

Replace the SpO2 module.

Replace the main board.

The main board malfunctioned. Update the software.

Replace the main board.

Information and error messages
This section presents tables of information and error messages to help you troubleshoot issues on
the device.

When the device detects certain events, a notification appears in the Device Status area at the top
of the screen. Below are the notification types.

• Information messages, which appear on a blue background.

• Error messages, which appear on a white background.

You can dismiss a message by touching the message on the screen, or, for some messages, you
can wait for the message to time out.

To use these tables, locate the message that displays on the device in the left column of the table.
The remainder of the row explains possible causes and suggests actions that can resolve the issue.

If you cannot resolve the issue, use the Service Tool to read the error log files or to perform a
functional test on the module reporting the message.

NOTE Performing functional tests on modules requires the Service Tool, Gold
edition.

Error logs are not viewable by clinicians. However, all logs are transferred to Welch Allyn on a
regularly scheduled basis. In the event of an unplanned power failure, all information, including
device logs and patient data, are retained on the system.

NIBP messages

Message Possible cause Suggested action

User cancelled NIBP reading. The NIBP measurement was
cancelled by user

Clear the message and retry NIBP.

NIBP not functional. 050002 The NIBP measurement is not
available

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

Unable to determine NIBP; check
connections; limit patient
movement. 050003

The NIBP measurement may be
inaccurate, patient motion
occurred, or the settings for patient
readings obtain might not be
accurate

Make sure the NIBP settings/patient
mode is appropriate. If the problem
persists, have the device inspected
by a qualified service technician.

Unable to determine NIBP; check
connections; limit patient
movement. 050004

Excessive artifact, no blood
pressure parameters could be
calculated

Unable to determine blood
pressure. Check connections;
restrict patient movement. If
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Message Possible cause Suggested action

problem persists, have the device
inspected by a qualified service
technician.

Unable to determine NIBP; check
inflation settings. 050005

Low inflation on blood pressure
measurement attempt

Make sure the NIBP settings/patient
mode is appropriate. If the problem
persists, have the device inspected
by a qualified service technician.

Unable to determine NIBP; check
connections and tubing for kinks.
050006

The NIBP tubing has a kink, or there
is a NIBP transducer calibration
failure

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

Unable to determine NIBP; check
connections; limit patient
movement. 050007

The blood pressure measurement
dumped too soon

Make sure the NIBP settings/patient
mode is appropriate. If the problem
persists, have the device inspected
by a qualified service technician.

Unable to determine NIBP; check
connections; limit patient
movement. 050008

There were not enough steps on
the measurement attempt

Unable to determine blood
pressure. Check connections;
restrict patient movement.

Unable to determine NIBP; check
inflation settings. 050009

There is invalid patient information
for the selected mode

Make sure the NIBP settings/patient
mode is appropriate. If the problem
persists, have the device inspected
by a qualified service technician.

Unable to determine NIBP; check
connections; limit patient
movement. 05000A

The re-inflation was too late on the
measurement attempt

Unable to determine blood
pressure. Check connections;
restrict patient movement.

Unable to determine NIBP; check
inflation settings. 05000B

There were many re-inflate
attempts on the measurement
attempt

Unable to determine blood
pressure. Check connections;
restrict patient movement.

Unable to determine NIBP; check
connections and tubing for kinks.
05000C

Couldn’t bleed pressure below safe
venous return pressure

Unable to release cuff pressure.
Check tubing for kinks and
connection integrity.

NIBP air leak; check cuff and tubing
connections. 05000D

Air leak in cuff or tubing Leak was detected in BP cycle.
Check the tubing and connections.

Unable to determine NIBP; check
connections; limit patient
movement. 05000F

Auto Zero check failure The NIBP pressure is not stable and
the transducer zero value cannot
be set. If problem persists, have the
device inspected by a qualified
service technician.

NIBP not functional. 050105 WACP message CRC mismatch on
NIBP module

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050201 This message is not implemented
by the NIBP module

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050202 This message is not supported by
the NIBP module

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.
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NIBP not functional. 050203 The NIBP module has run out of
memory

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050205 The NIBP module has received a
invalid parameter

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050206 The parameter provided by the
NIBP module is outside of the
allowable range for the specified
message

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050207 The NIBP module message requires
an object, but did not contain one

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050208 The NIBP module object provided
with the message could not be
deserialized

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050209 The NIBP module object could not
be serialized

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 05020A The NIBP module message is
performing a request or action
when the module state prohibits
the request or action.

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not calibrated. 050503 Factory EEPROM checksum error on
NIBP. Units internal configuration
was corrupted

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050504 User EEPROM checksum error.
Configuration data which can be
set in the user's configuration
menu was damaged or lost on NIBP

Calibrate the NIBP Module. If
problem persists, have the device
inspected by a qualified service
technician.

NIBP not functional. 050505 Post failure of A/D convertor Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not calibrated. Calibrate the
module. 050509

NIBP module calibration failure, the
calibration signature is zero

Calibrate the NIBP module.

Invalid algorithm. Select correct
algorithm and retry. 050512

Invalid NIBP Algorithm. NIBP
component software tried to
configure the sensor in an illegal
manner

Verify the algorithm. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050513 Invalid NIBP initiation code Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

Invalid patient mode. Select correct
patient mode and retry. 050514

Invalid patient mode on NIBP. The
NIBP component software tried to

Verify correct patient mode. If the
problem persists, have the device
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configure the sensor in an illegal
manner

inspected by a qualified service
technician.

NIBP not functional. 050515 Invalid module configuration for
NIBP

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050516 NIBP module malfunction Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

Ambient temperature out of range.
Clear error and retry. 050517

Ambient temp out of range on
NIBP

Restore device to normal
temperature ranges and try again.

Low battery. Plug into outlet.
050518

The NIBP module power rail is too
low

Plug device into an AC outlet to
charge the battery.

Battery overcharged. Disconnect
from outlet. 050519

The NIBP module power rail is too
high. NIBP was calibrated without
A/C connected or battery too low.

Battery is overcharged. Remove
from charging source. Charge
battery and initialize NIBP module
and recalibrate with A/C
connected.

NIBP not calibrated. Calibrate the
module. 050601

NIBP failed to load safety processors
calibration record from EEPROM

Calibrate the NIBP module. If the
problem persists, have the device
inspected by a qualified service
technician.

NIBP not functional. 050602 NIBP safety processor failed ROM
checksum

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not calibrated. Calibrate the
module. 050603

NIBP safety processor not
calibrated, missing calibration
signature

Calibrate the NIBP module. If the
problem persists, have the device
inspected by a qualified service
technician.

Cuff pressure limits exceeded.
050604

NIBP system failure. Overpressure Restrict patient movement.

Premature auto cycle skipped.
050605

NIBP auto cycle skipped, SVRP
requirement not satisfied

Cuff pressure is not below safety
return pressure long enough to
allow a cycle to occur.

Cuff pressure too high. Clear error
to retry. 050606

NIBP cuff pressure above SVRP for
too long

Verify cuff connections. If the
problem persists, have the device
inspected by a qualified service
technician.

NIBP not functional. 050607 NIBP cannot clear the failsafe errors Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050608 NIBP safety processor has stopped
responding

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.
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Stat mode requested too soon.
Clear to retry. 050609

NIBP excessive stat mode time. The
time between readings is less than
one minute and the readings plus
time between readings result in the
device taking over 15 minutes to
complete the averaging cycle.

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

Unable to determine NIBP; check
connections and tubing for kinks.
05060A

NIBP transducers are not matched The transducer are above 5 mmHg
and the difference in pressure is
greater than 40 mmHg. Check cuff
for pinched or obstructed tubing. If
the problem persists, have the
device inspected by a qualified
service technician.

NIBP not calibrated. Calibrate the
module. 05060B

Factory EEPROM checksum error on
NIBP. Units internal configuration
was corrupted

Calibrate the NIBP module. If the
problem persists, have the device
inspected by a qualified service
technician.

NIBP not functional. 05060C NIBP command not implemented Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 05060D NIBP wrong data count Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 05060E NIBP data range error Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 05060F NIBP no POST error to clear Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050610 NIBP cannot clear this POST error Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050611 NIBP command not command type Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050612 NIBP communication timeout Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician..

NIBP not functional. 050613 NIBP response header wrong Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050614 NIBP response checksum wrong Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050615 Too much NIBP data was received Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.
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NIBP not functional. 050616 NIBP FPROM erase error Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050617 NIBP FPROM programming error Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 050618 Invalid NIBP target pressure Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

Check cuff inflation settings. Cuff inflation target was overridden
due to max pressure being too low

Change cuff inflation target or
maximum pressure so that the cuff
inflation target is at least 20 mmHg
lower than maximum pressure.

NIBP not functional. 05FF01 Unrecognized WACP parameter
received from sensor

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 05FF02 Timeout waiting for sensor
response

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 05FF03 Error deserializing the WACP
message received from the sensor

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 05FF04 WACP stack send message failure Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 05FF05 Timeout waiting for asynchronous
sensor message

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 05FF06 One or more undetermined
numerics when reading status
indicates OK

Check connections. Restrict patient
movement.

NIBP not functional. 05FF07 Unrecognized sensor reading status
code

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 05FF08 Sensor power up failure Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 05FF09 WACP rendezvous failure Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 05FF0A Application firmware retrieval error
during POST

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.
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NIBP not functional. 05FF0B Upgrade .pim file is corrupt Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 05FF0C Configured upgrade firmware
directory cannot be accessed

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

NIBP not functional. 05FF0E The NIBP sensor unexpectedly reset Clear the error and try again

NIBP not functional. 05FF0F The NIBP sensor firmware failed to
upgrade

Internal malfunction. If the problem
persists, have the device inspected
by a qualified service technician.

SpO2 messages

General SpO2 messages

Message Possible cause Suggested action

SpO2 not functional.
044800

SpO2 not functional Internal hardware malfunction in SpO2
module. If the problem persists, have the
device inspected by a qualified service
technician.

SpO2 rebooting. 044900 The SpO2 module is not responding. Informational error. The host software is
attempting to clear an error by rebooting
the SpO2 module. No action required.

SpO2 rebooting. 044901 The SpO2 module stopped sending
data

Informational error. The host software is
attempting to clear an error by rebooting
the SpO2 module. No action required.

SpO2 rebooting. 044902 SpO2 received a packet with bad CRC
from module

Informational error. The host has received
a packet with bad CRC from the SpO2
module. The packet in question is
ignored. No action required.

SpO2 rebooting. 044903 The SpO2 power on self test failed Internal hardware malfunction in SpO2
module. If the problem persists, have the
device inspected by a qualified service
technician.

SpO2 rebooting. 044904 The SpO2 power on self test timed
out

Internal hardware malfunction in SpO2
module. If the problem persists, have the
device inspected by a qualified service
technician.
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Message Possible cause Suggested action

Sensor not connected.
Clear to retry. 040100

The SpO2 sensor is not connected Connect SpO2 sensor, if the problem is
still present, replace the SpO2 cable. If the
problem is still present, verify the module
functionality by replacing the sensor with
an applicable SpO2 tester. If the message
persists, have the device inspected by a
qualified service technician.

SpO2 interference
detected. Clear to retry.
040400

The SpO2 interference detected. Reapply the sensor to the patient. If the
problem is still present, replace the SpO2
sensor. If the problem is still present,
replace the cable. If the problem is still
present, verify module functionality by
replacing the sensor with an applicable
SpO2 tester. If the message persists, have
the device inspected by a qualified
service technician.

Low perfusion index. Clear
to retry. 040500

SpO2 marginal pulse quality or artifact Reapply the sensor to the patient. If the
problem is still present, replace the SpO2
sensor. If the problem is still present,
replace the cable. If the problem is still
present, verify module functionality by
replacing the sensor with an applicable
SpO2 tester. If the message persists, have
the device inspected by a qualified
service technician.

Temperature messages

Message Possible cause Suggested action

Temperature not functional. 030105 WACP message CRC
mismatch on
temperature module

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030201 This message is not
implemented by the
temperature module

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030202 This message is not
supported by the
temperature module

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030203 The temperature module
has run out of memory.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030204 No parameter provided
for the specified
message.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030205 The temperature module
received an invalid
parameter

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.
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Temperature not functional. 030206 The parameter provided
by the temperature
module is outside of the
allowable range for the
specified message.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030207 The temperature module
message requires an
object, but did not
contain one.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030208 The temperature module
object provided with the
message could not be
deserialized.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030209 The temperature module
object could not be
serialized.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 03020A The temperature module
message is performing a
request/action when the
module state prohibits
the request/action.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 03020B The temperature module
requested item is not
currently available due to
the module state.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030503 The temperature module
factory settings, and
calibration information is
corrupt.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030504 The temperature module
user settings are corrupt.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030509 The temperature module
calibration is not set.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 03050C The temperature module
error log is corrupt.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030516 A hardware malfunction
on the temperature
module has been
detected.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030518 The temperature module
power rail is too low.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

122 Appendix Welch Allyn® Spot Vital Signs 4400



Message Possible cause Suggested action

Temperature not functional. 030519 The temperature module
power rail is too high.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Unable to detect new temperature.
Retry measurement. 03051A

The temperature module
reference voltage circuit
was detected to be
under voltage or
unstable.

Probe malfunction. If problem persists,
replace probe. If the problem persists, have
the device inspected by a qualified service
technician.

Ambient temperature out of range.
Clear to retry. 030801

The temperature module
measurement is below
the allowable
temperature values and
beyond the low ambient
or patient limits.

Verify conditions are greater than 50 °F or 10
°C. If conditions are valid and the problem
persists, replace the probe. If the problem
persists, have the device inspected by a
qualified service technician.

Ambient temperature out of range.
Clear to retry. 030802

The temperature module
measurement is above
the allowable
temperature values and
beyond the high ambient
or patient limits.

Verify conditions are less than 104 °F or 40 °C.
If conditions are valid and the problem
persists, replace the probe. If the problem
persists, have the device inspected by a
qualified service technician.

Temperature not functional. 030803 The temperature module
internal calibration
resistor (RCAL) on the
board is damaged or
contaminated (pulse too
long).

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030804 The temperature module
internal calibration
resistor (RCAL) on the
board is damaged or
contaminated (pulse too
short).

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030805 The temperature module
internal circuit validation
resistor (PTB) on the
board is damaged (value
is over).

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030806 The temperature module
internal circuit validation
resistor (PTB) on the
board is damaged (value
is under).

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Ambient temperature out of range.
Clear to retry. 030807

The temperature module
A/D measurement timed
out

Verify conditions are greater than 50 °F or 10
°C. If conditions are valid and the problem
persists, replace the probe. If the problem
persists, have the device inspected by a
qualified service technician.

Replace temperature probe. 030808 The temperature module
probe was not
characterized/calibrated

Probe malfunction. Replace the probe. If the
problem persists, have the device inspected
by a qualified service technician.
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Insert correct color-coded probe
well. 030809

The temperature module
is missing the probe well

Insert the probe well

Temperature not functional. 03080A The temperature module
has a problem saving to
the device EEPROM in
biotech mode

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 03080B The temperature module
error detection
mechanism detected an
error

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Replace temperature probe. 03080C The temperature module
probe error detection
mechanism detected an
error

Probe malfunction. Replace probe. If the
problem persists, have the device inspected
by a qualified service technician.

Temperature not functional.
03080D

The temperature module
log error detection
mechanism detected an
error

Probe malfunction. Replace probe. If the
problem persists, have the device inspected
by a qualified service technician.

Temperature not functional. 03080E The temperature module
calibration error
detection mechanism
detected an error

Probe malfunction. Replace probe. If the
problem persists, have the device inspected
by a qualified service technician.

Connect temperature probe.
03080F

The temperature module
detected no probe
connected

Probe malfunction. Replace probe. If the
problem persists, have the device inspected
by a qualified service technician.

Replace temperature probe. 030810 The temperature module
cannot read the probe
EEPROM correctly or the
probe left the factory
without being tested.

Probe malfunction. Replace probe. If the
problem persists, have the device inspected
by a qualified service technician.

Temperature not functional. 030811 The temperature module
has an invalid events
index

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030812 There is a problem
reading the temperature
module EEPROM or
saving to the device
EEPROM in biotech
mode.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Replace temperature probe. Code
030813

The temperature module
has a problem reading
the probe EEPROM.

Probe malfunction. Replace probe. If the
problem persists, have the device inspected
by a qualified service technician.

Temperature not functional. 030814 The temperature module
TEMP CONFIG ACQUIRE
FAILURE

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.
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Temperature not functional. 030815 The temperature module
TEMP CONFIG RELEASE
FAILURE

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030816 The temperature module
TEMP CONFIG INVALID
PTR FAILURE

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030817 EEPROM not initialized Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Unable to detect new temperature.
Retry measurement. 030818

The temperature module
heater indicates on when
turned off.

Probe malfunction. Replace probe. If the
problem persists, have the device inspected
by a qualified service technician.

Unable to detect new temperature.
Retry measurement. 030819

The temperature module
heater indicates off when
turned on.

Probe malfunction. Replace probe. If the
problem persists, have the device inspected
by a qualified service technician.

Temperature not functional. 03081A The temperature module
HTR_Q is on and HTRC is
off but still has voltage.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 03081B The temperature module
HTR_Q is tri-stated with
HTRC enabled and has
heater power.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 03081C The temperature module
turned Q&C on and the
heater voltage is not high
enough.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional.
03081D

The temperature module
heater hardware failsafe
should have turned off
but did not.

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Replace temperature probe. 03081E The temperature module
probe is above 112°F or
43.3°C.

Probe malfunction. Replace probe. If the
problem persists, have the device inspected
by a qualified service technician.

Replace temperature probe. 03081F The temperature module
has excessive heater
energy

Probe malfunction. Replace probe. If the
problem persists, have the device inspected
by a qualified service technician.

Temperature not functional. 030820 The temperature module
host interface error

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Ambient temperature out of range.
Clear to retry. 030821

The temperature module
over ambient 45 °C temp

Verify conditions are less than 104 °F or 40 °C.
If conditions are valid and the problem
persists, replace the probe. If the problem
persists, have the device inspected by a
qualified service technician.
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Ambient temperature out of range.
Clear to retry. 030822

The temperature module
under ambient temp

Verify conditions are greater than 50 F or
10°C. If conditions are valid and the problem
persists, replace the probe. If the problem
persists, have the device inspected by a
qualified service technician.

Temperature not functional. 030823 The temperature module
has an invalid SureTemp
algorithm

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030824 The temperature module
is over max battery volts

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030825 The temperature module
is under min battery volts

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030826 The temperature module
battery volts not set

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030827 The temperature module
predict algorithm is not
set

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 030828 The temperature module
ambient temp is not set

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Replace temperature probe. 030829 The temperature module
has a non-responsive
probe. The thermistor has
pulled away from the tip
or the heater is broken.

Probe malfunction. Replace probe. If the
problem persists, have the device inspected
by a qualified service technician.

Replace temperature probe. 03082A The temperature module
is experiencing bad
probe gain

Probe malfunction. Replace probe. If the
problem persists, have the device inspected
by a qualified service technician.

Temperature not functional. 03082B The temperature module
has a bad probe response
value

Probe malfunction. Replace probe. If the
problem persists, have the device inspected
by a qualified service technician.

Temperature not functional. 03C800 The temperature module
is not functional

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 03C900 Unable to deserialize
messages from the
temperature module

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional.
03CA00

Unsupported message
received from the
Temperature module

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.
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Temperature not functional. 03CB00 Unable to send message
to the Temperature
module

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional.
03CC00

Temperature module
communication times
out

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional.
03CD00

Failed to upgrade the
temperature module

Internal malfunction. If the problem persists,
have the device inspected by a qualified
service technician.

Temperature not functional. 03CE00 Unable to read PIM file Retry the device update.

Temperature not functional. 03CE01 Upgrade file directory
could not be accessed

Retry the device update

Direct mode reading timed out Direct mode reading
times out

Direction mode reading times out

Tissue contact lost. Lost tissue contact while
attempting to acquire a
temperature
measurement or
acquired measurement
was performed with
limited tissue contact.

Check the tissue contact and try the
measurement again.

Temperature module reset. 03D000 Temperature sensor reset
unexpectedly

None

Patient data messages

Message Possible cause Suggested action

Database schema out of
data; recreating.

The database was cleared due to a
schema update

Information status message; press OK button
to dismiss.

Database is unreadable
during startup;
recreating. 1F0001

The database was unreadable
during startup

Press OK button to dismiss.

Error accessing PDM
database; restarting PDM.
1F0002

Database corrupted when device is
in operation

Press OK button to dismiss.

Maximum number of
patient records + Oldest
record overwritten.

Data was deleted as it contained
more than 50 records

Information status message; press OK button
to dismiss.

No data saved. A manual save is not allowed
Information status message; press OK button
to dismiss.

Save successful. A manual record was saved
Information status message; press OK button
to dismiss.
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System messages

Message Possible cause Suggested action

000001 System failure Restart the device

000002 System failure Restart the device

000003 System failure Restart the device

000004 System failure Restart the device

000005 System failure Restart the device

000006 System failure Restart the device

Internal hardware failure. The root file system is corrupted;
restart not possible

Restart the device. If the problem persists,
replace the main PCBA.

Internal hardware failure.
140100

EEPROM access failed. The device
boot is possible, but wired
communications are disabled

Reprogram the EEPROM. If the problem
persists replace the main PCBA.

Internal hardware failure. SPL memory test failure, the device
will sound an SOS pattern

Restart the device. If the problem persists,
replace the main PCBA.

Internal hardware failure.
1C1000

The device PIC communications
never starts or quits. The
communication won’t reasonably
recover at startup or during
operation

Restart the device. If the problem persists,
replace the main PCBA.

Low battery 30 minutes
or less remaining. 1C1005

The battery power is low Connect the power supply to AC power to
charge the device.

Low battery 5 minutes or
less remaining. 1C1006

The battery power is extremely low Connect the power supply to AC power to
charge the device.

Battery is critically low;
plug into outlet. Device is
shutting down. 1C1007

The battery power is critically low Connect the power supply to AC power to
charge the device.

Update unsuccessful.
Reboot and retry. 1C1008

The software update failed Restart the device. If the problem is still
present, replace the main PCBA.

Host battery not
charging. 1C100A

The host battery is not charging Restart the device. If the problem is still
present, check cable connections. If the
problem is still present, perform functional
checks for host. If the problem is still present,
replace battery. If the problem persists,
replace the main PCBA.

Factory default settings
now active. 3A0001

The factory configuration settings
are active

The device has been configured to factory
defaults, any user settings have been reset.

Internal hardware failure.
Device will shut down.
1C100D

Power supply issue. The PMIC is too
hot

Check the operating environment
temperature. Allow the device to cool down
before operating again. If the problem is still
present, check the cable connections. If the
problem is still present, perform functional
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Message Possible cause Suggested action

checks for host. If the problem is still present,
replace the battery. If the problem is still
present, replace the main PCBA.

Input voltage too low.
Device will shut down.
1C100C

Power supply issue. The PMIC input
voltage is too low

Check the operating environment
temperature. Allow the device to cool down
before operating again. If the problem is still
present, check the cable connections. If the
problem is still present, perform functional
checks for host. If the problem is still present,
replace the battery. If the problem is still
present, replace the main PCBA.

Unexpected restart
occurred. 1C1012

The device unexpectedly restarted Continue normal operation

Device battery is not
installed. 1C100E

There is no battery in the device Check the device for a battery and install one
if it is missing. If the problem is still present,
perform diagnostic checks on the device. If
the problem persists, replace the main PCBA.

Advanced settings
unavailable.

The advanced settings are
unavailable because the device is
not in an idle state

Confirm that no sensors are attached to the
device and there is no unsaved data.

Software upgrade is
downloading. Do not
shutdown.

Cannot power down device as
software install is in progress

N/A

Save not successful. The device configuration or logs
were not saved to the USB device

Information status message; press OK button
to dismiss

Save successful. The device configuration or logs
were saved to the USB device

Information status message; press OK button
to dismiss

Send successful. Data was successfully sent over
USB.

N/A

Power messages

Message Possible cause Suggested action

Device is operating in
battery mode

A/C power cord has been
disconnected

None

Sleep mode is
unavailable. An NIBP
averaging program is in
progress.

Sleep mode is not allowed when
intervals are in progress

Stop any active averaging programs or enter
sleep mode when averaging is complete.

Sleep mode is
unavailable. An error is
active.

Sleep mode is not available when
errors are active

Clear all active errors.
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Message Possible cause Suggested action

Sleep mode is not
available. Unsaved
readings are present.

Sleep mode is not allowed with
unsaved readings

Save or clear readings.

Software update messages

Message Possible cause Suggested action

Software Update:
Manifest transfer timed
out. Verify connection
and retry.

The manifest file transfer timed out
or connection was lost during
download

Verify the connection and retry.

Software Update:
Package file transfer
timed out. Verify
connection and retry

The package file transfer timed out
or connection was lost during
download

Verify the connection and retry.

Software Update: Invalid
token file.

There was an invalid token file Verify and update the token file.

Software Update: Unable
to find manifest file on
server.

Unable to find manifest file on
server

Verify the manifest file is on the server.

Software Update: Unable
to verify manifest file
signature.

Unable to verify manifest file
signature

Regenerate the software package and retry.

Software Update:
Package file corrupted.
Regenerate package and
retry.

The package file is corrupt, does not
have expected SHA256 hash

Regenerate the software package and retry.

Software Update: Unable
to find package file.

The package file cannot be found Verify the package file is on the server.

Software Update:
Installation failed. Reboot
and retry.

At least one of the sub systems
failed to install

Restart the device.

Software Update:
Upgrade unsuccessful.
Insufficient disk space.

The partition is running out of
space

Free up adequate space needed to perform
the upgrade.

Software Update: Update
unsuccessful.
Incompatible firmware.

The current firmware version is too
low to install update

Try to update to an earlier software package.

Software Update: SWUP
internal error

SWUP NIBP is not functional SWUP internal error.

Software Update:
Manager internal error

The Software Update manager is
not functional

Software Update Manager internal error.
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Identifying the device and subsystems
This explanation of the device labeling is provided to assist you in identifying these particular parts
by serial number. The part numbers appearing on the labels are internal part numbers and will not
be found in the list of field replaceable units (FRUs) included in this manual.

Future revisions of a part may not always be backward compatible with a legacy part. To determine
the correct replacement part for your unit always provide the serial number and model when
ordering.

Manufacture date: how to decode serial number
The Serial number (SN) of a device reveals many details about its manufacture. The last four digits
of the device SN reveal the device’s date of manufacture.

SN: XXXX####WWYY
where
XXXX = Manufacturing plant
#### = Sequential number of manufacture
WW = Week of manufacture
YY = Year of manufacture

Device serial number and model label
The model number and serial number can be found on a label on the back housing.

Serial number and format code

Serial number XXXX####WWYY

XXXX Manufacturing plant

#### Sequential number

WW Week of manufacture

YY Year of manufacture
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Device circuit board and internal options label

Circuit board and internal option labels

PCBA identifier XXXXXX BOM Y DWG Z

XXXXXX Welch Allyn material number

Y Bill of material (BOM) revision

Z Assembly drawing version from current version of
drawing

Circuit board and internal option labels

Serial number XXXXWWYYID

XXXX Sequential number

WW Week of manufacture

YY Year of manufacture

ID Unique vendor identifier

Model number format and code

Model configurations
NOTE For more configuration options, including approved accessories, see the
accessories list in the Instructions for use.

NOTE If options have been added to the device, the actual configuration will not
match the model description.

The device is available in multiple configurations. Use the following table to determine available
model configurations. Model numbers include one item from each column.

Example: 44WT-B (North America)

Example: 44XT-4 (United Kingdom)

Model Parameter
SpO2 Temperature

Power cord

44XT W = Welch Allyn / Nonin

X = Blank / None

T = SureTemp Plus B = North America

Y = Italy

2 = Europe

3 = Israel

4 = United Kingdom

44WT W = Welch Allyn / Nonin T = SureTemp Plus
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Model Parameter
SpO2 Temperature

Power cord

6 = Australia/New Zealand
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Interconnect diagram
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Service and maintenance toolset
 

Spot Vital Signs 4400 (Spot 4400)
The following is the listing of tools and test equipment required to perform basic functional
verification checks, full functional verification checks and calibration, and service and maintenance
on the device.

NOTE Tools and test equipment must be readily available to complete Welch
Allyn Technical Service Training for this device.

Material no. Description Qty

Usage

Full Basic

General test equipment

106275 Micro USB cable 1 X

N/A PC running Windows 10 1 X

web
download

Welch Allyn Service Tool 1 X

107334 Welch Allyn Service Tool, Gold license 1 X

NIBP testing

407672 BP test volume repair fixture 113670 1 X X

N/A Pressure meter (must include at least two
decimal points and be accurate to within ±0.5
mmHg)

1 X X

N/A Blood pressure Y-tube 1 X X

4500-30 Blood pressure hose, 5 ft. 1 X

620216 Fitting "Y" 1/8 X 1/8 X 1/8 1 X X

SpO2 configuration testing

N/A SpO2 simulator 1 X X
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Material no. Description Qty

Usage

Full Basic

SureTemp Plus configuration testing

06138-000 Cal-key, assembly, M690/692 1 X X

01802-110 Tester, calibration, 9600 Plus 3 X

Notes:
• All items marked "N/A" in the Material no. column are OEM or off-the-shelf tools and equipment not

available from Welch Allyn. The remaining items are available through Welch Allyn or a Welch Allyn
distributor.

• All items marked in the Full column are required for full functional verification checks and calibration.
The Welch Allyn Service Tool software and an active Gold license are required to perform these checks.
The Gold license is obtained upon successful completion of Welch Allyn Technical Service Training.

• All items marked in the Basic column are required for basic functional verification checks. The Welch
Allyn Service Tool software Standard unlicensed edition can be used to perform the NIBP checks and
SWF upgrades/updates.

Miscellaneous Tools
• Phillips #0 screwdriver

• Phillips #1 screwdriver

• T-10 Torx screwdriver

• 3/8" socket
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Service software IT setup
 

Installed Welch Allyn
service component

Required outbound network
Domain name
IP address

Port

Service feature description

Welch Allyn Service Tool

(via Windows service called
PartnerConnect)

servicehub.iot.hillrom.com/

IP: 52.224.38.138

HTTP/HTTPS port: 443

Inbound - Used by customers to receive
software/device firmware upgrades.

Outbound - Used by customers to send
device service information.

IP: 12.38.86.181

TCP port: 5094

Used to activate the Service Tool and
enable device feature licenses.

(This IP address does NOT respond to
"ping.")

PartnerConnect software servicehub.iot.hillrom.com

IP: 52.224.38.138

HTTP/HTTPS port: 443

Used by customers to receive software/
device firmware upgrades from Cumulocity.

Connex Server

(via Windows service called
PartnerConnect)

partnerconnect.iot.hillrom.com

IP: 52.224.38.138

HTTP/HTTPS port: 443

servicehub.iot.hillrom.com

Inbound - Used by customers to receive
software/device firmware upgrades.

Outbound - Used by customers to send
device service information.

Teamviewer Host
IP: multiple depending on geographic
location

Default TCP port: 80/443

(can be configured to use TCP port
5938)

Used by Welch Allyn Service personnel to
access a customer's machine (with
customer's consent/permission) to address
device issues.

Welch Allyn Service Hub servicehub.iot.hillrom.com

IP: 40.76.153.225 (inbound)

IP: 52.224.38.138 (outbound)

HTTP/HTTPS port: 443

Used by customers to view the status of
their devices and deploy firmware upgrades
and device configurations. The portal
requires prior account setup.

File outbound types .log, .xml, .zip, .txt

137



Installed Welch Allyn
service component

Required outbound network
Domain name
IP address

Port

Service feature description

File inbound types .tar.gz, .tar, .seq, .wsf, .pim, .xml, *.txt,
*.pdf
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Service record
 

Date: Time:

Device name: Serial number:

Technician: Service tool version:

NIBP tests
Specification Actual reading Pass Fail

Max: 5 mmHg mmHg

Mode Specification Actual reading

Adult mode: 280 . . . . 329 mmHg mmHg

Target pressure ± 5
mmHg Pressure meter Service tool

Specificati
on Pass Fail

0 mmHg mmHg mmHg ± 1 mmHg

50 mmHg mmHg mmHg ± 3 mmHg

150 mmHg mmHg mmHg ± 3 mmHg

250 mmHg mmHg mmHg ± 3 mmHg

SpO2 tests
Test Specification Actual reading Pass Fail

SpO2 pulse rate Pulse rate 60 ±1 bpm
bpm
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60 bpm 59 to 61 bpm

SpO2 saturation

90%

Saturation 90% ±1 sat
point

89 to 91%

%

Thermometry tests
Temperature test Specification ± 0.2°F (± 0.1°C) Actual reading Pass Fail

97.3 °F (36.3 °C) 97.1 to 97.5 °F 36.2 to 36.4 °C °F or °C

Temperature
tested Specification ± 0.2 °F (± 0.1 °C) Actual reading Pass Fail

96.8 °F (36.0 °C) 96.6 °F to 97.0 °F 35.9 °C to 36.1 °C °F or °C

101.3 °F (38.5 °C) 101.1 °F to 101.5 °F 38.4 °C to 38.6 °C °F or °C

105.8 °F (41.0 °C) 105.6 °F to 106.0 °F 40.9 °C to 41.1 °C °F or °C
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